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Welcome!

 

In a few short years the world has changed. Once music making was strictly di-
vided between those with access to professional studios, expensive equipment and 
other musicians, and those whose music making was confined to the realms of sec-
ond rate equipment, limited funds and a good deal of dreaming.

We at Steinberg are pleased to be part of the continuing revolution that has broken 
down these barriers, allowing anyone with musical ambitions to realise their true 
musical potential.

The Cubase VST you now have in front of you, is our finest achievement to date. It 
embodies the experience of over ten years of Steinberg history. Whether you are a 
seasoned professional musician or someone starting out in music, Cubase VST pro-
vides the finest easy-to-use tools, and the best framework for your music.

Karl Steinberg              Manfred Rürup
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About Cubase...

 

Now that you have Cubase VST, you belong to one of the largest music software 
user groups in the world. Cubase is a family of music software, ranging from the 
easy-to-understand package for the beginner to professional tools for the most de-
manding applications. That's the Cubase advantage, Cubase grows as you develop 
musically. 

Cubase may come in different versions and on different computer types, but it's al-
ways a Cubase. What you learn now will be just as valid if you decide to change to 
another version or another type of computer. We developed a method of working 
with music software that has re-defined 'ease of use', and set the standard.

Cubase VST was created as a result of years of experience in both software engi-
neering and listening to our users. The Cubase of today is a very different product 
compared to its first release. A major component of this continuing success story is 
your active involvement. We welcome suggestions and comments about Cubase 
VST and the direction it should take in the future. Also we are very pleased to see 
independent Cubase Clubs appearing all over the world. These create networks of 
expertise and advice which helps all Cubase users.

Cubase is used by Hollywood film composers, world class recording studios, au-
dio-visual facilities, and – of course – every conceivable type of musician. We are 
very proud of this, and would like to thank you for becoming part of the Cubase 
family.

Your Steinberg Team.
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How to find your way around the Manual and the On-
line Help

 

The documentation for Cubase VST comes in several flavors:

 

The Installation booklet

 

This separate booklet describes how to install the program. This is the first item you 
should read.

 

Getting Started (this document)

 

This document is the on-line version of the printed Getting Started book. It contains 
the following:

 

• A Guided Tour in which you can find out about Cubase VST.
• Introductions to the various aspects of the program, allowing you to try out 

many of the possibilities.

 

In other words, this document is not a complete description of all the features of the 
program, but a good way to get started.

 

• Getting into the Details.

 

This is the main documentation, containing detailed descriptions of Cubase 
VST parameters, functions and techniques. When we refer to the “Electronic 
Documentation” in this document, we mean the Getting into the Details doc-
ument (if nothing else is stated).

 

• Score Printing and Layout.

 

If you have the Score or Audio XT version of Cubase VST, the program in-
cludes a more advanced Score Editor. This editor is described in the Score 
Printing and Layout document.

 

• MIDI Mixer and Mix Tracks.

 

Describes how to use the MIDI Mixer in Cubase VST to control levels and pa-
rameters in your MIDI instruments from within the program.

 

• IPS.

 

This document describes how to use the Interactive Phrase Synthesizer.

 

• Controlling Tape Recorders.

 

If you plan to use Cubase VST together with a multitrack tape recorder, this 
document contains information about how to do this, using Tape Tracks.

 

• The Modules documents.

 

In the subfolder called “Modules” you will find a document about how to use 
Modules in Cubase VST, as well as separate documents for each Module that 
is included with your program version.

 

• The VST Plugins documents.

 

In the subfolder called “VST Plugins” you will find documents describing 
each of the audio plug-in effects that are included with your program version.
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So, what should I read?

 

• In either case, follow the instructions in the Installation booklet.
• Then, if you want to get acquainted with the program, read this document 

and refer to the electronic documentation whenever necessary.
• If you know you want to learn as much as possible about this program, you 

should make sure to read this document and all the included electronic doc-
umentation documents.
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About the On-line Help

 

Cubase VST comes with Windows Help. There are several ways of bringing up the 
Help texts:

 

• To see a list of topics in the Help file, select Contents from the Help 
menu.

• To get general information about a window or a dialog, press the [F1] key 
on the computer keyboard or click the Help button in the dialog.

 

A Help text is displayed, describing the current window or dialog box. 

 

• To get specific information about an item in a dialog box, click the Ques-
tion mark on the window’s title bar. Then click on the item you want to 
get information about.

• To get information about a menu item, pull down the menu, position the 
pointer over the item and press [F1].

 

A Help text is displayed, describing the selected menu item.

 

• To get more information about how to use the Windows 95 Help, pull 
down the Help menu and select “Using Help”.

 

●

 

Some items are described in detail in the On-line Help only!

 

How you can reach us

 

You can find us at the World Wide Web, at the following address:

 

www.steinberg.net 

 

On the web site you can do the following:

 

• Find support information, answers to frequently asked questions, etc.
• Send email to our support personnel.
• Download the latest update of your program and demo versions of other 

Steinberg products.
• Communicate with other Steinberg users in the User Area.
• There are also sections for Education and Multimedia users.
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Guided Tour 2
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What is Digital Audio?

 

“Audio” is any sound source that you can connect to the sound input of your PC au-
dio card; a microphone, an electric guitar or similar. “Digital” we say because the 
computer converts the audio signal to numbers, which Cubase VST captures and 
stores on your hard disk. This convertion of sound into a stream of numbers opens 
up an enormous range of possibilities for creatively manipulating your recordings.

 

What is MIDI?

 

MIDI is a type of control information used with synthesizers. Let’s explain this 
with an analogy: Your computer can send messages to a printer about how you want 
a page to look. The printer then takes care of converting this information to the ac-
tual “ink” on paper.

With MIDI the synthesizer works much like a “musical printer”: the computer 
sends information to it, specifying which notes you want it to play, and it takes care 
of actually creating the audio.

One of the advantages of this technique is that a recording made with for example a 
piano sound can be played back with a harpsichord, brass or guitar sound, just by 
changing settings on the synthesizer.

General MIDI (abbreviated GM) is an additional specification for MIDI instru-
ments. If an instrument or sound card is General MIDI compatible, it will have a 
common, wide ranging set of sounds built in (piano, bass, drums, brass, strings etc). 
If you create music with a General MIDI compatible instrument it can be played 
back on any other GM instrument and the music will sound more or less the same. 
This allows you to share your Cubase VST songs with other people, and even pub-
lish your works in a common data format, for example on the Internet!

Cubase VST also supports two extensions to the GM standard, called GS (Roland) 
and XG (Yamaha).
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The Main Windows in Cubase VST

 

The Transport Bar

 

This is much like the transport control on any tape recorder. This is where you Play, 
Stop, “wind the tape” etc. But the Transport bar is also used for setting tempo, time 
signature etc.

These buttons are the 
equivalents of the transport 
controls on a regular tape 
recorder.

Tempo and Time 
Signature

Activates the 
metronome.These are used for 

defining where to start 
and end recording and 
what section to Cycle.

These fields show you 
the current Song 
Position in bars, beats 
and ticks (to the left) and 
in tine position format 
(to the right)

When you activate this, 
the program will cycle 
the section between the 
Locators.

These indicators show MIDI In 
(recording) and Out (playback) 
activity.
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The Arrangement

 

This is where you record and assemble your Songs.

Vertically, the Arrangement is divided into Tracks, letting you organise your re-
cordings. You might use one Track for drums, another for bass, a third for main vo-
cals, a fourth for vocal harmonies, etc.

The right part of the Arrangement is called the Part Display. 

The Track 
List

This symbol 
indicates an 
Audio Track

Click in this 
column to Mute 
(silence) a Track.

The Track’s 
channel

The name of the 
Track. Double 
click to change.

This symbol 
indicates a 
MIDI Track

This button 
opens the 
Inspector

The active 
(selected) Track. 
Recording always 
happens on the 
active Track.

This symbol 
indicates a 
Drum Track

This symbol 
indicates a 
Mix Track

Time runs from left to right, as the ruler indicates.

The Song Position The Left Locator The Right Locator

Each recording you make appears in the 
Part Display as a box, called a Part.
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At the top of the Arrange window is a bar with various pop-ups and settings.

The vertical position of the Part 
shows you which Track it is on.

The horizontal position shows you where in the Song the Part starts.

The width of the box shows you 
the length of the recording.

In the Part you will see a visual representation of the recording.

Click here to listen to the 
selected Track only

The “precision” for editing 
operations, like moves and splits

This note value is used for 
the Quantize function.

The mouse pointer’s position 
in bars, beats and ticks.

This pop-up is used to give 
different Parts different colors.
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The Audio mixer windows

 

The Monitor Mixer window is where you mix your Audio Tracks, that is, adjust the 
levels (volume), stereo panning, effect sends, EQ, etc. 

The final output is adjusted in the Master window:

Mute and 
Solo buttons

Pan controls

Level fader

Level meter

Mixer 
automation 
controls

Clip indicator

Input level 
switch

Insert Effect 
buttons

Level meters

Master Effect 
displays

Level faders
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The EQ and Effect windows

 

For each audio channel in Cubase VST, you can have up to four bands of paramet-
ric equalization. Furthermore, each channel has four effect sends, which you can 
assign to four internal “effect processors” for adding reverb, chorus and other ef-
fects.

Apart from the four send effects, which are common to all audio channels, you can 
have up to four different Insert Effects per channel. These are accessed via the In-
sert buttons in the Monitor Mixer window (see the picture on the previous page). 
There are also four Master Effects, which are inserted into the master output bus.

Equalizer sectionEffect sends

The four Send Effects
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The GM/GS/XG Editor

 

This is one of the places where you can adjust the levels, panning and other param-
eters for the sounds created by your MIDI synthesizer. If you use MIDI instruments 
that are compatible with one of the standards GM, GS or XG, you can also use this 
editor to select sounds for each MIDI channel.

 

The Pool

 

This window lists all your audio recordings. It is also used to import audio files cre-
ated in other programs, for use in Cubase VST.

Use this menu to import Files created in 
other programs.

This is a file containing an 
audio recording.

These are segments that play parts of the file. 
By dragging segments into the Arrangement, you can use the audio file in your Song.
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The Audio Editor

 

This is the window where you do the basic editing of your Audio Parts, moving and 
trimming start and end points of Audio Events, etc.

 

The Wave Editor

 

This window is for detailed editing and permanent alteration of the actual audio re-
cordings.
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The MIDI Editors

 

There are four different editors for editing your MIDI recordings: 

 

Key Edit

 

This editor consists of a “grid” with the notes shown as boxes. The pitch of a note 
is indicated by the vertical position, and the note length is indicated by the width of 
the box. This is the editor to use when you want quick graphical editing of notes 
and continuous controllers, such as modulation and volume.

 

Drum Edit

 

This editor is similar to Key Edit, but designed specially for editing drum and per-
cussion Tracks. Each Drum Sound has its own row and settings, making it easy to 
create and change rhythm patterns. 

Continuous Events

Notes

Drum Sounds

Notes
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List Edit

 

In this editor, all MIDI notes, controllers and other Events are shown in a list. You 
can move, insert and delete Events in the list and perform detailed editing of all val-
ues. List Edit is useful when you want absolute control over values and positions, or 
if you are a “computer type of person”, used to numerical editing.

 

Score Edit

 

Here, the MIDI notes are presented as a musical score. Use Score Edit to make 
printed scores, or simply if you are used to working with musical notation.

The Event List MIDI Events The Event Display
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Quick Start 3
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About this Chapter
This chapter gives you a really quick introduction to Cubase. It is based on the 
Quick Start demo Song, included on the CD-ROM. 

● We assume that a Windows compatible sound card has been already installed 
(as described in the Installation booklet) and tested as working with the Win-
dows’ Media Player.

Opening the Quick Start Song
1. Insert the Cubase CD-ROM disc into the drive.

2. Use the Explorer application to copy the folder Quick Start Song on the 
CD-ROM to your hard disk.

3. Open the Quick Start Song folder, on your hard disk, and locate the Cu-
base Song file with the same name. Double click on it.
Cubase launches, and the Song opens. What you see now is the Arrange win-
dow, the real focus of Cubase.

Playing Back
At the bottom of the screen you will find the Transport Bar. This is used to control 
playback, recording and many other functions, much like the controls on a regular 
tape recorder.

The transport controls.

1. Click the Play button, on the Transport Bar.
The Song starts playing. At this point, you will only hear the audio Tracks, that 
is, audio recordings stored on your hard disk as files. No MIDI is played at this 
point.

2. When you are done listening, hit Stop. Also try out Fast Forward and Re-
wind to see how you can move the Song Position (the vertical moving 
line in the Arrange window) to any point in the Song and start playback 
from there.
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Muting and Soloing Tracks
As you can see, the Arrange window is divided into a number of Tracks. These are 
listed vertically. You can silence any number of Tracks, by using the functions Mute 
and Solo.

1. Click in the “M” column in the Tracks list, for the Track Bass.
You will notice how the bass disappears from the music. Click again to get it 
back. What you just did was muting and unmuting a Track.

2. Experiment with muting/unmuting Tracks but leave the Tracks Vibes and 
Strings muted for now.

3. Click on the name of the Track Bass.
The Track goes dark. What you just did, was selecting a Track. Selecting 
something means it is now the target for some operation you are about to per-
form.

4. Click on the Solo button, at the top of the Arrange window.
You will now hear only the selected Track. Solo can be thought of as a sort of 
inverse mute. Click Solo again to hear all the unmuted Tracks.

The Solo button A Muted Track

This Track is selected
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Activating the MIDI Tracks
The two Tracks at the bottom, called Vibes and Strings, do not play audio but MIDI. 
You can see this by checking the “C” column for the Track. The note symbol indi-
cates that a Track is a regular MIDI Track whereas the waveform symbol indicates 
an audio Track.

To be able to play the MIDI Tracks you need to have an audio card with a synthe-
sizer on it, or an external MIDI synthesizer connected to a MIDI Interface. If your 
synthesizer is not General MIDI compatible, you might still play the Tracks, and 
you will probably hear something, but it might not be the sounds we assume in this 
example.

1. Make sure your synth is in its General MIDI compatible mode.
Most synths are on startup already in this mode.

2. Click twice on the Stop button to move the Song Position to the begin-
ning of the Song.

3. Unmute the two Tracks Vibes and Strings.

4. Activate playback.
You will now hear, from the MIDI synthesizer, some additional parts in some 
sections of the Song. If you don’t hear anything, check the Output column for 
the MIDI Tracks and make sure they are set to the correct “port”. 

Audio Track 
symbol

MIDI Track symbol
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Changing the Sound of a MIDI Track
Now, let’s try to make some changes to the sound and levels of the MIDI Tracks. 
The easiest way to do this (although there are others) is to use the GM/GS/XG Ed-
itor.

1. Let the music keep playing.

2. Select “GM/GS/XG Editor” from the Edit menu.
A window with faders, knobs and other controls, opens. The 16 sections rep-
resent the 16 MIDI channels in your General MIDI instrument. The Vibra-
phone sound you are hearing is playing on channel 1 and the Strings on 
channel 2.

The text fields at the bottom of the window indicate the names of the sounds.

3. Adjust the “Vol” faders for channels 1 and 2.
These faders transmit MIDI messages to your MIDI synth, instructing it to ad-
just the volume on these MIDI channels. If nothing happens, make sure that 
the Mode pop-up menu in the lower right corner of this window is set to 
“GM”, and that the Output pop-up menu below it is set to the “port” that your 
General MIDI synth is connected to.

4. Position the mouse over the Program selection item for channel 1.

5. Click with the mouse button.
A hierarchical Program menu appears.

6. Select some sound from this menu.
The Vibes part will now play back with the sound you just selected instead. If 
nothing happens, this is because your instrument is not set up to receive the 
MIDI message Program Change.

7. If you like, experiment with the other controls in this window.

8. When you are done, close the GM/GS/XG Editor.
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Setting the Levels of the Audio Tracks
Now that you’ve learned how to mix the MIDI Tracks, let’s do the same for the au-
dio Tracks.

1. Rewind the Song to the beginning and activate playback.

2. Select “Monitor” from the Audio menu.
The audio Monitor mixer appears. Here you can see, via the colored bar 
graphs, which audio channels are playing (in this example, each audio chan-
nel corresponds directly to an Audio Track, so that Track 1 plays back on au-
dio channel 1, and so on).

The Monitor window.

3. Use the channel faders to adjust the levels of the Tracks, as desired.
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Adding an Effect
Now, let’s add some audio effects to the Guitar Track. To hear what we’re doing, 
let’s Solo it first.

1. Locate Track Guitar, the one labelled “Chan 4” at the bottom, and click 
on its Solo button (at the top of the “channel strip”).

2. Click on the same Track’s FX button, located just above its Solo button.
The EQ and FX Send window for that channel appears. Essentially this is a 
mixer window with detailed settings for one channel only.

The effect settings in the EQ/FX window.

The section we are interested in now is the one to the far left, with the four blue 
knobs. These represent controls for the amount of effect for this audio channel. As 
you can see from the labels, there are four effect available.

1. Click on the On buttons for all four effects.

2. Use the knobs to add various amounts of each effect to the Guitar sound.
To do this, press the mouse button with the pointer over the knob, keep the 
button down and drag in a circular motion around the knob.

Drag in a circular motion around the knob.

3. When you are done, close the FX window, click the Solo button again to 
deactivate Solo and finally close the Monitor window.
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Checking Out the Arrange Window Toolbox
So far you’ve been mixing and setting sounds. Now it’s time to explore the possibil-
ities of editing the music. This is mainly done in the Arrange window, using a 
graphical Toolbox that allows you to manipulate recordings.

As you have probably noted, the recordings on the Tracks are made up of Parts, 
small boxes that each represent a musical recording, regardless of whether it con-
tains audio or MIDI. Editing in the Arrange window means manipulating these 
Parts.

Parts in the Arrange window.

1. Position the pointer somewhere in the area where all the Parts are (the 
Part Display) and press the right mouse button.
A Toolbox appears.

The Arrange window Toolbox.

2. Select the Eraser Tool.

3. Click on one of the Parts.
It disappears - because you just erased it!

4. Select Undo from the Edit menu.
The Part comes back.

5. Select the pointer from the Toolbox.

6. Position the mouse pointer over any Part, press the mouse button and 
drag.
The Part moves. If you like, play back to hear the effect.

7. Select one Part. Then hold down [Shift] and click on more Parts, one af-
ter the other.
They all get selected and turn dark to indicate this.

8. Press the mouse button with the pointer over one of the selected Parts, 
and drag.
They all move together, as a block.

9. If you like, try out the other Tools.
The functions of the most common Tools are described in the chapter “Work-
ing in the Arrange window”.
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Checking the Contents of the Parts
The Arrangement is fine for block editing purposes, like repeating a chorus etc. 
However, there will be many instances when you will want to perform more de-
tailed manipulations of your recordings. For this you use the various Editors.

1. Double click on a Part on an audio Track.
The Audio Editor opens. This has a Toolbox and a number of controls, menus 
and settings all of its own. If you like, experiment with the possibilities.

2. Close the Audio Editor.

3. Double click on a MIDI Part.
The Key editor opens. This is one of a number of MIDI editors, each one 
streamlined for a certain type of work.

4. Again, experiment with the possibilities, if you like.

5. Close the Key editor.

Closing Up
This finishes our quick tour of the demo Song. By now you are probably anxious to 
record something of your own. Proceed to the next chapter to get an introduction to 
the basic methods and concepts used in the program, and then get ready for a 
unique musical experience, using Cubase VST to realize your own musical inspira-
tions.

● Apart from the Quick Start Song, there may also be other Demo Songs in-
cluded on the CD-ROM. Use these to try out other features and get an impres-
sion of the full capacity of Cubase VST!
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4

Basic Methods 4
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Why you should read this Chapter
In this chapter, none of the actual features of Cubase VST are described. Instead, 
the chapter contains information about the general methods you need to employ 
when using Cubase VST, plus some useful terminology. These methods are the 
same in every part of the program, no matter if you are making a basic recording or 
using Cubase VST at its most advanced level. To make your work with Cubase VST 
as effective as possible, please take the time to read this chapter.
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Using Tools
When you are working with Cubase VST, you need different tools in different situ-
ations. You may for example want to input notes or import audio using a Pencil 
tool, or delete notes using an Eraser tool. There are a lot of other tools as well.

Some examples of tools

About Toolboxes

The various tools used in certain situations, are gathered in Toolboxes. Each is es-
sentially a “frame” containing an icon for each tool. Most of the windows in Cu-
base VST have their own Toolbox.

Some examples of Toolboxes

Selecting a Tool from a Toolbox

1. Press the right mouse button.
Make sure the pointer is not positioned over a numerical value field, as this 
will instead increase the value (see page 37).

2. The Toolbox appears.

3. Move the pointer to the tool you want to select, and release the mouse 
button.
The Toolbox disappears and the pointer takes on the shape of the selected 
tool.
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Pop-Up Menus
Throughout the program you will select values from pop-up menus. These differ a 
bit from the regular “menu bar menus”. Pop-up menus may be located anywhere in 
a window, and are not on a menu bar. But, selecting is done identically from all 
menus, pop-up or regular.

Press the mouse button with the pointer 
positioned on the small triangle...

...to pull down a pop-up menu.
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About Positions, Lengths and Resolution
Cubase VST works with a MIDI resolution of 384 fractions (or ticks) per quarter 
note. You will often work with position values in the Arrange window and in the 
MIDI editors. Positions in Cubase VST are displayed in one of two formats: 

• Meter Positions
Meter Positions are divided into Bars, Beats (quarter notes) and Ticks. This is 
the most commonly used position format in Cubase VST.

For example, if you place the Song Position pointer one sixteenth note into the third bar, the 
position will be displayed like this: “3.1.96” (third bar, first beat, 96th tick).

• Time Positions
Time Positions and lengths are shown as “hours: minutes:seconds:frames”. 
How many frames there are to each second depends on the frame rate, as set 
in the Synchronization dialog box. See the “Synchronization” chapter in the 
electronic documentation.

MIDI Note Lengths

MIDI Note lengths are always displayed as ticks. In the table below, some common 
note values are shown as ticks:

Note Value Ticks Note Value Ticks

Whole note 1536 Eighth note 192

Half note 768 Eighth note triplet 128

Dotted Quarter note 576 Dotted sixteenth note 144

Quarter note 384 Sixteenth note 96

Dotted eighth note 288 Sixteenth note triplet 64

The beginning of the Song, 
displayed as a Time position.
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Setting Values

Different types of values

There are three basic kinds of values displayed in Cubase VST:

• “Normal” values.
• “Segmented” values, i.e. values divided into two or more “subvalues”. Exam-

ples of these are positions, tempo, time signature, etc.
• Note Pitches.

Some different values.

Changing values

There are several ways to change a value in Cubase VST:

• Click on the value with the left or right mouse button.
The left button decreases the value, the right button increases it. 
For each click, the value changes one step. If you hold down [Shift] while 
clicking, the value will change in larger steps (often steps of ten).

• Scroll the value up or down by pressing and holding down one of the 
mouse buttons with the pointer over the value.
The left button decreases the value and the right button increases it. 
If you hold down [Shift] while using the mouse, the value will scroll in larger 
steps (often steps of ten).

• Hold down the [Control] key, click on a value and drag the mouse up or 
down with the button pressed. 
The whole screen will act like an invisible scroll bar or fader, which you can 
use to change the value.

• Double click on the value, type in a new value and press [Return].
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About changing “segmented” values

If you are using the mouse to change a “segmented” value such as a position or a 
decimal number, you can change any one of the “segments” individually. In a posi-
tion value for example, you can change the bar, beat and tick values independently, 
just by positioning the pointer at the right numeral.

If you are changing a segmented value by typing, you can use spaces, dots, commas 
or any character that is not a number, to separate the numerals. However, you don’t 
have to type in all the numerals. If you just type in a single number, you will change 
the largest numeral in the segmented value, and all the lesser numerals will be set to 
their lowest values:

About editing Note Pitches

If you are editing a pitch (note number) by typing, there are two ways of typing it: 
as a note name (a letter followed by a number and maybe a #-sign) or as a MIDI 
note number (a number from 0 to 127, where 0 is the lowest note).

In some windows you also have the option to edit note pitches via MIDI:

1. Double click on the pitch value.

2. Press a key on a connected MIDI keyboard.
The value gets the pitch of the key you press.

3. Press [Return].

Clicking on the “Beats” value...

...will change this value only

Double clicking on this 
value (Song Position)...

...brings up a value 
box.

If you type a single value 
and press [Return]...

...the lesser numerals get their 
lowest values automatically.

You may enter a MIDI note number, 
for example 37...

...but Cubase VST will display the name of the note (here C#1).
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Naming
You can give names to Tracks, Parts and many other items in Cubase VST. To edit 
a name just double click on it. The text gets highlighted and you can type in the 
changes you want to make. You can use the arrow and [Backspace] keys, just as in 
any text-editing program.

Window Techniques
Cubase VST is a Windows 95 program, which means that you may move, resize, 
scroll and close windows using standard Windows 95 procedures. There are also a 
couple of special features:

Changing the Magnification

In the Arrange window and most of the editors, a small slider appears on each 
scroll-bar. The slider on the left/right scroll bar changes the horizontal magnifica-
tion. The slider on the up/down scroll bar changes the vertical magnification. By 
dragging the slider to the right/downwards, you increase the magnification. Drag-
ging the slider to the left/upwards will decrease magnification.

You can also change the magnification from the computer keyboard, using the fol-
lowing keys:

[G] Decrease horizontal magnification.

[H] Increase horizontal magnification.

[Shift]-[G] Decrease vertical magnification.

[Shift]-[H] Increase vertical magnification.

Double clicking on the name... 

...highlights it and makes it ready to edit.

The vertical magnifying slider

The horizontal magnifying slider
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Dividers

Some of the windows in Cubase VST are divided into two or more sections. The 
“borders” between the sections are called Dividers. If you position the pointer on a 
Divider, the pointer takes on the shape of a hand. You can then click on the Divider 
and drag it in the direction of one of the sections. This way, you will shrink that sec-
tion and enlarge the other.

Dragging the Divider in the Arrange Window.
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Using the Computer Keyboard
When you are working with Cubase VST, the computer keyboard has several dif-
ferent uses:

Transport Controls

The Transport functions (such as Play, Stop, Record and so on) can all be managed 
from the computer keyboard. The keyboard commands for these functions are 
mainly located on the numeric key pad to the right on the computer keyboard. See 
page 101 in this document.

● You can use the numeric key pad to control the transport functions, even if 
the Transport Bar is hidden or a dialog is open.

Keyboard Shortcuts

Many of the items in Cubase VST’s menus have a computer keyboard equivalent - 
a “shortcut”. These keyboard shortcuts generally use the keys to the left on the 
computer keyboard. 

How Keyboard Commands are displayed in this Manual

The following list shows how the “special” keys on the computer keyboard are dis-
played in this manual.

When the text says something like “press [Control]-[T]” this means that you should 
hold down the Control key on the computer keyboard and press T once.

● Some key commands involve pressing two modifier keys, for example: “press 
[Control]+[Alt]-[T]”. The “+” sign between the modifiers means that you 
should press the Control key and the Alt key at the same time, hold them 
down and then press T once.

In this manual: On some keyboards:

[Shift]

[Alt] Alternate

[Control] Ctrl

[Tab]

[Return]

[Backspace]
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Undo
Cubase VST has a very wide-ranging Undo function. This means that if you regret 
your last action, you can Undo it. This is very helpful when something doesn’t turn 
out as intended. Remember that it is only the last action that can be undone.

You Undo an action by selecting “Undo” from the Edit Menu, or by pressing [Con-
trol]-[Z] on the computer keyboard.

If you wish to “Undo the Undo”, this is possible. The menu text changes to “Redo” 
after an Undo (for example “Redo Delete”). If the menu item is grey, nothing can 
be undone.

Often the menu item Undo tells 
you what will be undone at any 
given moment. In this case, 
“Undo Delete” means the last 
deletion will be undone.
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Setting up Audio

● This chapter (and in fact the whole Getting Started book) assumes you are us-
ing one “standard” audio card, with analog stereo inputs and outputs. 
If you have an audio card with several inputs and outputs, you find informa-
tion about activating different Inputs and routing audio to different Outputs in 
the electronic documentation. 
To get a grip on the basic audio procedures in Cubase VST, we recommend 
that you set up and connect your audio hardware so that it resembles a stand-
ard “two in/two out” card, and try out the possibilities described in this docu-
ment. Then go on to learn about the Output Bus features as described in “The 
Input/Output Bus System” in the electronic documentation.

Connecting your system - Inputs and Levels

Example 1 – The simplest possible MIDI and Audio system

The simplest audio/MIDI system you can have is an audio card which also contains 
a MIDI synthesizer.

In this system, the microphone, plugged directly into the audio input on the card, is 
used to record audio. The stereo output on the card delivers both the output from 
the audio tracks (the material recorded with the microphone) and the output from 
the MIDI synthesizer on the card.

Audio Card with
MIDI synth
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Example 2 – A Basic system including an External Mixer

Standard Windows audio cards often do not provide optimal audio quality for re-
cording the output of a microphone.

To improve sound quality, it is often preferable to connect the microphone (or other 
device you plan to record onto audio Tracks) to an external mixer and then connect 
the audio output of that mixer to the audio card.

In addition to this, more advanced MIDI synthesizers are normally in external 
boxes. This means you have two audio sources that you want to hear in your speak-
ers or headphones – the output from the audio card and the output from the synthe-
sizer(s). Again, the solution is to connect it all to a mixer.

The picture below shows a setup that includes both these functionalities.

In the example above, a special output on the mixer called a “monitor send” or a 
separate “bus” is connected to the input of the audio card. This ensures you can sep-
arately control what gets recorded on an audio Track.

The main outputs of the mixer are connected to the speakers, and it is via this con-
nection you are able to hear the output of the audio card and the synthesizers, 
blended to a final mix.

Naturally, there are endless variations on the above concept depending on the type 
of mixer, the sources to be recorded and the specification of the audio card. Contact 
your music dealer for help on configuring a system ideal for your specific needs.

Recording From a CD player

Most PC computers come with a CD-ROM drive that can also be used as a regular 
CD player. Normally, the CD player is connected via a special connector to the au-
dio card so that you can record the output of the CD-player directly into Cubase 
VST.

Audio Card

Send/Bus Out

MainOut
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The Sound Card Setup application

Normally, a sound card has several inputs: a microphone input, a stereo line input, 
possibly digital inputs and maybe a connection from the CD-ROM drive in your 
computer (see above).

With the sound card you should have received one or more small applications that 
allow you to configure the inputs of the card to your liking. This includes:

• Selecting which in/outs are active.
• Turning monitoring via the card on/off.
• Setting levels for each input. This is very important!
• Setting Levels for the Outputs, so that they match the equipment you use for 

monitoring.

About Recording Levels and Inputs

When you connect your equipment, please remember that different types of devices 
deliver different types of audio signals.

• Microphones and electric guitars deliver low level signals. The term used is 
indeed “microphone level”. These types of sources should always be con-
nected to a microphone input.

• Mixers, synthesizers, tape recorders and many other devices deliver a 
stronger signal called a “line level signal”. These should always be connected 
to a “line input”.

It is very important to make sure you use the correct type of input on your audio 
card, or your recordings will either be distorted or unnecessarily noisy. 

● Cubase VST does not provide any input level adjustments, since these are 
done differently for each card. Adjusting input levels is either done in a spe-
cial application included with the card or possibly from an ASIO control 
panel, accessed from Cubase VST’s Audio System dialog box.

About Monitoring

In Cubase VST, Monitoring means listening to the signal being recorded while pre-
paring to record or while recording. There are basically three ways to monitor:

• Via a Mixer
If you have the equipment connected to a mixer and then to the audio card, 
you can of course chose to listen to the connected equipment directly from 
the mixer. If you should chose this option or not depends on how advanced 
your mixer is.

• Directly via the audio card.
In this case, the audio input on the card is connected directly to its output. 
You set this up with the mixer application that comes with the card.

• Via Cubase VST
In this case, the audio passes from the input into Cubase VST and back to the 
output. You then control monitoring via settings in Cubase VST.
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Which should I choose - “Card” or “Cubase” monitoring?

• Monitoring via Cubase VST has the advantage that any effect and other 
settings you make in the program will also be apparent on the monitored 
signal, not only on recordings you have already made and play back.
This will not be the case if you use the card for monitoring.

• Monitoring via Cubase VST has only one disadvantage: There is an una-
voidable delay in the Monitor signal (the monitored sound will appear to 
be a little late). This is due to the way audio is handled on PC computers/
audio cards.
Normally, audio card monitoring does not have this problem.

Setting up

• If you want to use Cubase VST’s monitoring, make sure any monitoring 
(“through”) function is deactivated in the card’s mixer application.

• If you instead want to use the card’s monitoring, make sure this function 
is activated in the card’s mixer application. Also select the Global Disa-
ble monitor option in Cubase VST’s System dialog (found on the Audio 
menu).

System and ASIO Settings

1. Select “System...” from the Audio menu.

The System dialog.

2. Make sure that “ASIO Multimedia Driver” is selected on the ASIO De-
vice menu.
Again, this assumes you are using a regular Windows audio card. If you have 
a card for which there is a special ASIO driver, you should select that driver. 
See the electronic documentation for details.
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3. If required, adjust the Number of Channels in the Audio Performance 
section.
How many channels you will actually be able to use depends on your com-
puter’s processing power, the speed of the hard disk and other factors.

4. Click Apply.

5. Click on the ASIO Control Panel button.
The ASIO Multimedia Setup panel appears. This is used to set up your audio 
card.

The ASIO Multimedia Setup panel.

6. Pull down the Presets pop-up menu.
This contains pre-programmed setups for some common audio cards, but you 
can also add your own Presets here (see the electronic documentation).

7. Select the Preset for your audio card.
There may be several Presets for a single audio card type. For example, you 
may be able to select a “half duplex” or a “full duplex” setup. “Full duplex” 
means that the card has the ability to record and play back at the same time, 
which is a great benefit. If your audio card supports this feature (see the audio 
card documentation), make sure to select the “full duplex” Preset.

8. Close the dialog by clicking OK and then close the System dialog.
Once the settings are done, they are automatically saved together with the 
program.
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If there is no Preset for your audio card

If you cannot find a Preset for your audio card model, you need to set up the card 
manually:

1. In the ASIO Multimedia Setup dialog, click on the “Advanced Options...” 
button.
A dialog with more settings appears.

2. Locate your audio card in the Output and Input Port lists and make sure 
the checkboxes to the left in both lists are activated for your card.
If you have more than one audio card in the computer, only one should be 
active at this point. See the electronic documentation for info on more ad-
vanced options.

3. If your card has the ability to record and play back at the same time 
(“full duplex”), make sure that this option is activated on the Card Op-
tions pop-up menu in the lower right corner of the dialog.
If you are unsure about your specific card’s ability, check its documentation.

4. Click OK to close the Advanced Options dialog and the basic ASIO Mul-
timedia Setup dialog, and finally close the System dialog.
The settings are automatically saved together with the program, but you can 
go back later and save your Advanced ASIO Multimedia settings as a Preset 
(see the electronic documentation).
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Enabling/Disabling Audio

On the Audio menu you will find a setting called Disable Audio, which allows you 
to disable all audio input and output. This feature is mainly for two situations:

• When you only want to record and play back MIDI and don’t want to 
waste processing power on the audio engine.
This allows the computer to use all its power for screen updates and MIDI 
playback.

• When the computer you use is not powerful enough to run Cubase VST 
with the VST engine enabled.
Note the following:

• The setting is automatically saved in the Cubase VST preferences. This means 
that if you disable the Audio Engine, it will remain disabled until you enable 
it again.

• It is only CPU processing power that is preserved. The program will still use 
the same amount of primary memory (RAM) and disk space.

• All audio functionality is actually intact, it is only audio recording, playback 
and synchronization that are disabled. If you like, you can for example per-
form “silent editing” of audio in this mode.

Disabling audio on startup

• To disable audio on startup, hold down [Shift] while launching Cubase 
VST.
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Setting up MIDI
This section describes how to connect and set up MIDI equipment. If you have no 
MIDI equipment you can skip this section and move directly to page 56.

Connecting the MIDI Equipment

The descriptions below describe four setup examples for small MIDI systems. You 
might need or want to hook things up differently!

Example 1A – Using the same Keyboard for recording and playback, via a 
separate MIDI Interface

1. Connect the MIDI Out of the instrument to a MIDI In on the MIDI inter-
face.
If you have several, it doesn’t matter which MIDI In you use. Cubase VST can 
record from all inputs on a multi-port interface.

2. Connect a MIDI Out on the interface to a MIDI In on the instrument.

Your MIDI interface may have more than one MIDI Out. Each MIDI port can 
address up to 16 different devices (or the 16 different voices in a multitimbral 
module ). On smaller MIDI interfaces, the Outputs all carry the same informa-
tion, so it doesn’t matter which you use. 

On larger, multi-port interfaces, the MIDI Outputs are all separate, that is, 
they carry different sets of the 16 midi channels. This allows Cubase VST to 
send MIDI data selectively to different MIDI channels on any of the available 
outputs. If you have a multi-port interface, you should connect the first output 
to your instrument, and use the following outputs if you need to connect 
more instruments.

MIDI In
MIDI Out



- 52 - 

Example 1B – Using a Keyboard with a built-in MIDI Interface

If your instrument has a built-in MIDI interface, no MIDI cables are needed, only a 
serial cable (see the instrument’s documentation for cable specifications).

1. Make the connections with computer and instrument turned off.

2. Connect the cable between the serial port on the computer and the com-
puter connection on the instrument.
Many instruments have a special switch that needs to be set for the computer 
connection to be active (see the instrument’s documentation).

The connection above allows you to feed the computer with the signals from the 
keyboard, during recording. It also allows you to send MIDI signals from the com-
puter to the instrument during playback.

Example 2– Using a separate Keyboard and Sound Module

If you have a separate MIDI keyboard, that produces no sound, and a sound module 
without keyboard, you should hook things up as in the picture below. Using Cubase 
VST’s MIDI Thru feature (described later) you will still be able to hear the sound 
from the sound module while playing the keyboard and when recording.

Computer Connection

MIDI In
MIDI Out
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Example 3 – Adding more devices using the MIDI Thru connectors on the 
instruments.

You might want to use more instruments for playback. Connect MIDI Thru on the 
first instrument to MIDI In on the next, and so on. In this hook-up, you will always 
play the first keyboard when recording. But, thanks to the Thru connection, you can 
still use all your devices for providing sounds on playback.

● If you plan to use more than three sound sources we recommend that you ei-
ther use an interface with more than one output, or a separate MIDI Thru box 
instead of the Thru jacks on each unit.

Example 4 – Using a separate Keyboard and MIDI Card

If you have a card in your computer with a built in MIDI synthesizer, you don’t 
need to make any MIDI connection to get Cubase VST to play back from the card. 
However, to be able to record MIDI data you need at least a separate MIDI key-
board, that produces no sound but only transmits MIDI signals. This should then be 
connected to MIDI In on the computer.

MIDI In
MIDI Out
MIDI Thru

MIDI In

MIDI Synth
inside computer

MIDI Out
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Setting up the Instruments

If you have a General MIDI, Roland GS or Yamaha XG compatible instrument, 
make sure it is set to its GM/GS/XG mode. If you have other types of instruments, 
set each Sound (Timbre, Part, Program, Patch) to receive on a different MIDI Chan-
nel.

Setting MIDI Thru and Local On/Off

In the “MIDI Setup” dialog on the Options menu, you will find a setting called “MIDI 
Thru” which can be enabled or not. This is related to a setting in your instrument called 
“Local On/Off” or “Local Control On/Off”.

• If you use a MIDI keyboard instrument, as described in Example 1 earlier in 
this chapter, MIDI Thru should be activated and that instrument should be set 
to Local Off (sometimes called Local Control Off – see the instrument’s oper-
ation manual for details). This will let the MIDI signal from the keyboard get 
recorded into Cubase VST and at the same time re-routed back to the instru-
ment so that you hear what you are playing, without the keyboard “trigger-
ing” its own sounds.

• If you use a separate MIDI keyboard, that does not produce any sounds itself, 
as in Example 2, MIDI Thru in Cubase VST should also be activated, but you 
don’t need to look for any Local On/Off setting in your instruments.

• The only situation where MIDI Thru should be deactivated is if you use Cu-
base VST with only one keyboard instrument and that instrument cannot be 
set to Local Off mode.

MIDI In
MIDI Out

“Synth”

When “MIDI Thru” is active in 
Cubase VST, MIDI data received is 
immediately “echoed” back out.

When you 
press a key, it 
is sent out via 
MIDI to 
Cubase VST.

MIDI data coming in to 
the instrument is played 
by the “Synth” inside it.

When Local Control is On in the 
instrument, the keys you press will be 
played by the “Synth” inside the Instrument.
When Local Control is turned Off, this 
connection is cut off.
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Checking your MIDI Setup

1. Play your MIDI keyboard.

2. Check the “In” indicator on the Transport Bar so that you are sure that 
Cubase VST receives MIDI data.

3. If you have Thru activated, the “Out” indicator should indicate Output 
of data.

4. Make sure you hear the instrument that you are playing.
If not, check your MIDI connections and Cubase VST’s MIDI Thru setting. 
Also check the audio equipment and audio connections.

5. If you listen to the sound of the same instrument as you are playing, 
make sure the sound from the instrument doesn’t sound “thin” or 
“flanged”.
If it does, you have probably not set the instrument to Local Off. This means 
that every key you press is played twice, once directly on the instrument and 
once via MIDI.

Saving the settings

The Audio Hardware Setup settings are automatically saved by Cubase VST. Any 
other settings you have made you will want to save, so that you don’t have to redo 
them each time you launch Cubase VST:

1. Pull down the File menu and select “Save As...”.

2. Click on the “Song” file type selector.

3. Make sure you save in the same folder as where you have your Cubase 
VST program.

4. Type in the name “DEF.ALL” (make sure you type the name exactly like 
that, but without the quotes of course!).

5. Click Save.
Now the next time you launch the program, the basic Song settings you just 
saved will automatically be loaded (see page 241).

When this lights up, Cubase VST is 
transmitting MIDI data.

When this lights up, 
Cubase VST is receiving 
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Preparations done! Where do I go next?
There are basically two things we suggest you do:

• Read through the rest of this document and try out the different possibil-
ities as you go along.

• Read the sections of the electronic documents that interest you, to get 
more detailed information about each section of the program.
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Recording Audio 6
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Preparations

Selecting a Sound Source

Before you begin recording, you have to select which sound source to record. You 
may for example have a microphone connected, as well as some kind of line level 
instrument or mixer, and the audio output of an internal CD drive. Depending on 
which audio card you use, you may be able to make this selection from inside Cu-
base VST, by clicking the ASIO Control Panel button in the Audio System dialog 
(see page 45). For many audio cards, however, the input source selection and other 
settings are made in a small, separate application program included with the audio 
card. See the documentation for the audio card.

● A standard stereo audio card often allows you to mix several input sources. 
However, if you plan to record a single sound source, we recommend that 
you turn down or deactivate the other sources, to avoid unnecessary noise.

Activating Cubase VST Inputs

Cubase VST allows you to use audio cards with several Inputs and route different 
Inputs to different audio channels. This Getting Started book however, assumes you 
are using a “basic” 2 in/2 out audio card (or, if you have a larger audio card, that 
you are using the two first Inputs only). Still, you need to make sure that these In-
puts are activated before you attempt to record anything:

1. Pull down the Audio menu and select Inputs.
The Input window appears:

The left column contains the available “physical” Input ports (in this case there are two 
Inputs). The fields in the right column show the names that will be used for each Input 
throughout the program. The middle column contain an indicator for each input pair, 
showing which Inputs are active.

2. Make sure that the indicator in the middle column is lit.
If not, click on it so that it lights up. This shows that the Inputs are active.

3. Press [Return] on the computer keyboard to close the Inputs window.

● Read more about the Inputs in the chapter “The Input/Output Bus System” in 
the electronic documentation.
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Choosing a Sample Rate

Before you can start recording you have to set the sample rate for the Song:

1. Open the System dialog (on the Audio menu).

2. Use the Sample Rate popup to select a sample rate.
This setting determines the audio quality of your recordings. The higher the 
value, the better the quality, but when you raise the value, each recording 
also uses up more disk space and computer processing power. For recordings 
where the audio quality is important, 44100 Hz is the most common sample 
rate. For multimedia purposes, or in situations where you want to keep the 
audio files reasonably small, 22050 Hz may be a better choice.
Please note that some audio cards might only support a limited number of 
sample rates (see the card’s documentation for details).

● This setting is done once and for all for the whole Song. You can not make 
some recordings at one sample rate and others at some other sample rate.

3. Close the dialog by clicking OK.

Once the settings are done, they are automatically saved together with the program.
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Setting a tempo and time signature for the Song

Before you start you should decide for a tempo and time signature. These are both 
adjusted on the Transport bar:

Tempo tip

A good way of setting the tempo is to activate playback and adjust the tempo on the 
Transport Bar while listening to the metronome (Click) that is generated on each 
beat (quarter note). For the metronome to be heard, you need to make sure that the 
Click button on the Transport bar is activated:

● If you start playback with Click activated and still cannot hear the metro-
nome, you need to adjust the settings in the Metronome dialog on the Op-
tions menu (use the Online Help to find out about the parameters and options 
in the dialog).

For now, make sure Master is not 
activated on the Transport bar.

The time signature determines the overall “feel” of the beat. 4/4, for 
example is often used in rock and pop. 3/4 is used for waltz.

The tempo determines the “speed” of 
the music. The number is in beats 
(quarter notes) per minute. 

For now, we recommend you 
leave the Cycle deactivated.

Click activated on the Transport Bar.
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Selecting and setting up a Track
Before you select a Track to record on, it is necessary to understand something 
about audio channels and how Cubase VST handles mono and stereo recordings: 

• All audio is played back via audio channels. The maximum number of audio 
channels is determined by the settings in the Audio System dialog and your 
computer/hard disk performance. 

• Each audio channel can play back one mono audio recording at a time. 

• Stereo recordings play back on two audio channels, one for each “stereo 
side”. A stereo channel pair always consists of an odd channel and the next 
even channel (eg. channel 1+2, 3+4, etc).

• Channels that are used in stereo pairs cannot be used for mono recordings.

For more information on audio channels, see the chapter “How Cubase VST han-
dles Audio and MIDI” in the electronic documentation.

Set up a Track for recording as follows:

1. Select an Audio Track by clicking on its name field in the list.

• If you don’t have any empty Audio Tracks in your Arrangement, you need 
to create one, for example by using the Create Track item on the Struc-
ture menu. 
To make sure the Track is an Audio Track, position the mouse in the “C” col-
umn for the Track, pull down the pop-up menu and select “Audio Track”.

An Audio Track.
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2. Set the Track's channel (Chn) to the audio channel you plan to record on.
If this is the first Audio Track you record on, select 1. Generally, you should 
avoid using a channel already used by another Track, since each channel 
only can play one recording at the time.

The “any” channel setting is explained in the electronic documentaion. For 
now, select a “normal” channel number.

● If you plan to make a stereo recording, you need to select an odd channel 
number.

3. Open the Inspector.
This is done by clicking on the Inspector icon below the Track list.

Click on this icon...

...to open the 
Inspector.
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4. Decide if you want the recording to be mono or stereo by using the 
Mono/Stereo switch in the Inspector.
The label on the switch (Mono/Stereo) indicates which mode is currently se-
lected for the Track. But the switch also indicates whether it is possible to 
switch mode or not:

If you select Stereo for a Track, it will use the audio channel you set in step 2 
above for the left side of the stereo recording, and the next channel for the 
right side. These two channels are then reserved for stereo use, so that no 
mono Track can be set to any of these channels. For more information about 
this, see the chapter “How Cubase handles Audio and MIDI” in the On-line 
documentation.

5. Double click on the Track name, type in a new name for the Track and 
press [Return].
Now you need to make sure that the correct inputs are selected for the audio 
channel(s) you have selected:

The Track is set to Mono. You 
can switch to Stereo by 
clicking on the button.

The Track is set to Stereo. You can 
switch to Mono by clicking on 
the button.

The Track is set to Mono and cannot be 
switched to Stereo. This is either 
because the Track is set to an even 
channel, or because the next channel is 
already used for a mono recording.

The Track is set to Stereo and 
cannot be switched to Mono. This 
is because there is already a stereo 
recording on the Track.



- 64 - 

6. Pull down the Audio menu and select Monitor.
The Monitor mixer window opens.

7. Locate the “mixer strip” for the audio channel(s) you have selected for 
recording.
There is one mixer strip for each audio channel (the value you set in the Chn 
column for the Track on page 62 in this chapter). At the top of the strip, you 
find a button with the name of the Input selected for the channel.

8. Hold down [Control] and click on the Input button to pull down a pop-up 
menu with the available Inputs.
In this example, we assume that you are using a “regular” audio card with 
stereo inputs, but you may also have more advanced audio hardware with 
several inputs. 

9. Select the Input to which your sound source is connected.
If you have selected Stereo above, you need to select different Inputs for the 
two audio channels.
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10.Go back to the Arrange window and click on the Record Enable button 
in the Inspector, to make the Track and its selected audio channel ready 
for recording.
If this is the first time you enable audio recording in the Song, you will be 
asked to select a folder for storing your recorded audio files.

Selecting a folder for your Audio Files

When you enable recording for the first time in a new Song, a file dialog box will 
appear, asking you for a folder for your audio files. The folder you select will be 
used to store all audio files recorded for the Song. If you have the opportunity, we 
recommend that you store your audio files on a separate hard disk.

• If you want to change folder during the session, you can do this at any 
time by selecting “Select Audio File Folder” on the File menu.
This opens the same file dialog, letting you select a new folder, which will be 
used from that point on.

Monitoring

As described on page 46, you can monitor via Cubase VST or directly via the audio 
card.

If you monitor via Cubase VST, and Record Enable a Track, monitoring is usually 
automatically activated for that audio channel. This means that you will hear the 
audio source connected to the channel input, when in Stop mode and when actually 
recording. 

• You can also turn “Cubase” monitoring on and off manually, by clicking 
on the Input button in the Monitor window or in the Inspector.

● If you cannot get monitoring in Cubase VST to work at all, pull down the Au-
dio menu, select System, and check if the Global Disable monitor option is 
selected (if this function is enabled, Cubase VST will not provide monitoring 
at all). Select Tape Type monitoring, exit the System dialog and try turning 
monitor on in the Inspector again. The other monitoring options are described 
in the Online help.
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Checking the Input Levels

Digital recording (as in Cubase VST) is different from analog recording when it 
comes to recording levels. Whereas with analog recording it is often perfectly ac-
ceptable to let the “needle hit the red” (record at levels actually higher than the sys-
tem can reproduce accurately), this is not true when it comes to digital recording.

The term used here is headroom. The headroom is the difference in level between 
the signal you record and the maximum level the system can handle. When the sig-
nal increases, the headroom diminishes towards 0 dB (decibels). 

When the signal is stronger than the system can handle - when you exceed the 
available “headroom” - in a digital recording system, hard clipping occurs, which 
results in clearly audible and very unpleasant distortion. To avoid this, you should 
use the Input meter function in the Monitor window to accurately check the record-
ing levels, and then adjust the input level in one of the ways described in step 4 be-
low.

1. Pull down the Audio menu and select Monitor.
The Monitor Mixer window opens.

2. Click the “In” button above the level meter for the recording channel to 
activate the Input meter function.

In this mode, the meter shows the signal level at the input selected for the au-
dio channel.

• If you are making a stereo recording, activate the “In” buttons for both 
channels in the stereo pair.
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3. Sing or play the connected instrument and check the meter and the nu-
meric level display above the fader.
The level should be as high as possible, without ever clipping (exceeding 
0dB).

4. If needed, adjust the recording level in one of the following ways: 
• Adjust the output level of the sound source or external mixer.
• Use the audio card’s own application program to set the input levels, if this 

possibility is provided (see the documentation for the audio card).
• Click the ASIO Control Panel button in the Audio System dialog in Cubase 

VST and adjust the input level in the control panel that appears.
This requires both that your audio card supports the ASIO Control Panel func-
tion, and that there are input level settings in the control panel for the card.

5. When you are done, click on the “In” button again.
When the button is deactivated, the meters show the output level of each au-
dio channel.

6. While you are in the Monitor Mixer window, you may want to adjust the 
output level of the monitored channel.
Use the volume fader for the channel to set a comfortable listening level.

Clipping is indicated by the red 
clip light above the “In” button. 
To reset the clip indicator, click 
on it.
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Performing the first recording

Setting start- and end-points for the recording

There are several ways to start and end recordings. In this example, recording will 
start at the position of the Left Locator and end at the Right Locator (for more info 
about this, see page 81).

To position the Locators, Simply click on the ruler - the left mouse button sets the 
Left Locator to where you clicked, the right button sets the Right Locator.

Recording

1. Make sure the buttons on the Transport Bar are set up like this:

2. Click the Record button.

3. After the two bar count-in, start performing.
Recording will automatically be deactivated when you reach the Right Loca-
tor, if you don’t hit Stop before that.

4. When you are done, press Stop.
The program will now calculate an image file so that a waveform can be dis-
played in the program. Depending on the length of your recording, this may 
take a few seconds, during which a dialog box shows the progress of the cal-
culation.

The program has now created an audio file in the folder you selected on page 65. 
The file will appear in the Pool (a window containing a list of all audio used in the 
Song, see page 150). In the Arrange window, a Part is created between the start and 
end points of the recording. The Part contains an audio segment, which in turn 
plays back the whole audio file you just recorded.
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• A segment is a piece of an audio file. Read more about audio files and 
segments in the chapter “How Cubase handles audio and MIDI” in the 
electronic documentation.

Listening to the Recording

1. To hear what you just did, use the Transport Controls to move back to the 
beginning of the recording and click Play.

2. Stop when you are done.

If you don’t like what you just recorded

There are two ways you can get rid of a recording that you are not satisfied with:

Using Undo

If after recording you select Undo from the Edit menu, the Part you just created will 
disappear and you can record again. However, the audio file still resides on the hard 
disk and there is a segment for it in the Pool (see page 151 for details). You can al-
ways later delete unused segments and files, so this is nothing to worry about.

Deleting the Part

The other option is to manually delete the Part and then record again on the Track.

• If you delete the Part as you would with a MIDI Part, it disappears, but 
the segment and the audio file are not deleted (just as when you use 
Undo, see above).

• If you select the Part, hold down [Control] and press [Backspace], a dia-
log appears, asking you if you also want to delete the audio file. To do 
this, click OK.
This is the method to choose if you are sure you permanently want to delete 
the recording.
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Recording more on the same Track
To record more on the same Track, proceed as follows:

1. Move the Left Locator to the next position where you want to start re-
cording.
This can be at a “free” area on the Track, or at some place where something is 
already recorded, as described below.

2. Make sure the Right Locator is to the right of the Left Locator. If it isn’t, 
please move it.
Move the Right Locator by clicking in the ruler with the right mouse button or 
by changing the value in the Right Locator box on the Transport Bar.

● You cannot activate recording if the Locators are positioned in “reverse or-
der”.

3. Activate recording just as you did the first time on the Track.
A new file is automatically created.

About overlap

When you record again, where something has already been recorded on the Track, 
you will get a new Part which overlaps the previous one(s). However, when you 
play back, only the Parts that you can actually see are played back. Generally: One 
audio channel can only play back one audio file at the time.

Recording the Next Track - Overdubbing
Recording the next Track is done just as with the first. Here follows a summary of 
the steps:

1. Select another audio Track and make sure it’s set to another audio chan-
nel.

2. Set up the Locators and activate recording.

Now, the previously recorded Tracks will play back and you are able to record the 
new Track as an overdub.
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Basic MIDI Recording 7



- 72 - 

About this chapter
In this chapter, you will learn how to make a basic MIDI recording. 

This chapter assumes the following:

• That you have connected a MIDI keyboard (or other controller) and some 
kind of MIDI sound source. As described in the examples in the chapter “Set-
ting up your System”, this could be a MIDI keyboard with a built-in sound 
source, or any combination of a MIDI controller and a sound module, exter-
nal or built-into the audio card in the computer.

• That the MIDI sound source you use is General MIDI compatible and set to its 
General MIDI mode.

• That you are already familiar with Audio Recording as described in the previ-
ous chapter.

● If your instrument is not General MIDI compatible, you will not be able to se-
lect sounds from the Program pop-ups in Cubase VST (see page 76). How-
ever, the actual recording procedure will be the same.

Tempo, Time Signature and Click

If this is your first recording in a new Arrangement, set up the time signature, tempo 
and Click as described on page 60 in this document.

Selecting and naming a Track

Tracks with a note symbol in the “C” column are for MIDI recording. An Arrange-
ment can contain an unlimited number of MIDI Tracks.

1. Select a Track by clicking on its name in the list.

• If you don’t have any empty MIDI Tracks in your Arrangement, you need 
to create one, for example by using the Create Track item on the Struc-
ture menu. 
To make sure the Track is a MIDI Track, position the mouse in the “C” column 
for the Track, pull down the pop-up menu and select “MIDI Track”.

2. Double click on the Track name, type in the name you desire and press 
[Return].
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Setting MIDI Channel and Output

Setting the MIDI Channel in the Instrument

Most MIDI synthesizers can play several sounds at the same time, each on a differ-
ent MIDI Channel. This is the key to playing back several sounds (bass, piano etc.) 
from the same instrument.

Some devices (such as General MIDI compatible sound modules) always receive 
on all 16 MIDI Channels. If you have such an instrument, there’s no specific setting 
you need to make in the instrument.

On other instruments you will have to use the front panel controls to set up a 
number of “Parts”, “Timbres” or similar so that they receive on one MIDI Channel 
each. See the manual that came with your instrument for more information.

Setting the MIDI Channel and Output in the Track List

1. Set the Chn column for the Track to the same MIDI Channel as you just 
setup to use on the synthesizer.

2. Drag the Track List Divider all the way to the right, to reveal the Output 
column.

Dragging the Divider...

...reveals the Output column
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3. Make sure the Track you plan to record on is set to the MIDI Output that 
the synthesizer is actually connected to. If it isn’t, pull down the Output 
menu for that Track and select the desired MIDI Output.
If you only have one standard MIDI interface, that is limited to 16 MIDI Chan-
nels, then this setting is probably correct as it is. If you for example have a 
standard MPU compatible interface installed, this should say something like 
“MPU-401”.

Clicking in the Output column 
brings up a pop-up which lists 
the available MIDI Outputs 
plus an item called MROS.
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Selecting a sound and setting levels

When you play your keyboard, you should now hear the sound that the instrument 
plays on this MIDI Channel (the Track’s “Chn” setting).

To select a sound and adjust its level, proceed as follows:

1. Pull down the Edit menu and select “GM/GS/XG Editor”.

A window with 16 sections of controls, one for each MIDI Channel, appears.

2. Locate the Device section in the lower right corner of the window.

3. Use the Mode pop-up to select GM, GS or XG Mode.
Select the mode that is appropriate for your instrument.

4. Pull down the Output pop-up and select the MIDI Output port that your 
instrument is connected to.

5. Locate the channel section corresponding to the MIDI Channel you have 
chosen.

6. Press the mouse button with the pointer over the “Program” box at the 
bottom of the channel section.
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7. Use the hierarchical menus to select a sound.

8. Play the keyboard to try out the new sound.

If you don’t get the desired sound, this could have many causes:

• The Output of the GM/GS/XG Editor is not set to the MIDI Output that your 
instrument is connected to. Check the Output popup menu in the Device sec-
tion.

• Your instrument is not set to its General MIDI (or GS/XG) mode. Make sure 
the correct mode is selected on the Mode pop-up in the Device section, and 
then click the button to the right (labelled “Reset” or “GM On/Off” depending 
on the selected mode), to set the instrument to its GM/GS/XG mode. 
Please note that when GM is selected, the button (labelled “GM On” or “GM 
Off”) is used to switch the instrument in or out of GM mode. Click on the but-
ton to send the command that is currently shown on the button to your instru-
ment. In other words, to activate GM mode, click on the button until it says 
“GM Off”.

• Your instrument is not set up to react to MIDI Program Change messages. 
Consult the documentation for the instrument you are using.

• Your instrument isn’t General MIDI compatible. In this case, you should set 
the Mode pop-up in the Device section to “Off” and try selecting sounds for 
each MIDI channel manually on the instrument instead.

9. Adjust the “Vol.” fader for the channel to adjust the volume of the sound, 
if desired.

10.Close the window.

Verifying the Settings

Now when you play your keyboard you should hear the right sound in the synthe-
sizer (and only that sound). If not, check the following:

• Is the Track set to the correct MIDI channel?
• Is the Track set to the MIDI Output the instrument is connected to?
• Do you have MIDI Thru enabled in Cubase VST?
• Do you have Local Off activated in your instrument (if needed and/or availa-

ble)?
• Do you have the correct sound selected in the synthesizer?
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Recording
1. Set start and end points using the Locators, and decide if you want a 

Click or not, just as when recording audio.
If you pull down the Options menu and select “Metronome...” you can select 
whether you want an audio click from the computer (“Beep”) or a MIDI click, 
or both. The MIDI click settings are described in the On-line help.

2. Click the Record button.
By default, you will get a two bar count-in. This can be changed in the Metro-
nome dialog.

3. Perform the recording and press Stop.
A Part appears. 

You can now listen, Undo or record more on the same Track, just as with Audio 
Tracks.
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About overlap and the Overdub/Replace switch

MIDI Tracks are different from Audio Tracks when it comes to overlapping Parts. 
When you record again, where something has already been recorded on the Track, 
the result is determined by the setting of the Overdub/Replace switch on the Trans-
port Bar:

Overdub

In this mode, the new recording is simply added to whatever was on that Track be-
fore. When you play back, you will hear both recordings. This can be used crea-
tively when you are recording in Cycle mode, as described in page 92.

Overdub Mode is probably the safest way to record. If you add too much music, 
you can simply remove it later by editing (see the chapter “An Introduction to MIDI 
Editing”). Up until now, we have assumed that this switch was in Overdub mode.

Replace

In this mode, whatever you record replaces what was previously on the Track. Re-
place mode is probably the best choice if you have made a mistake and wish to cor-
rect it by recording something new.
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Recording different types of MIDI Messages
There are a few facts about the recording of some types of MIDI messages that can 
be useful to know. If you don’t know too much about MIDI you may not under-
stand everything below. Later when you have gained a more thorough understand-
ing, come back and read this information.

Notes

In MIDI, when you press and release a key on your synth or other MIDI keyboard, 
a Note On (key down) and a Note Off (key up) message are sent out.

The MIDI note message also contains the information which MIDI Channel was 
used. Normally, this information is overridden by the MIDI Channel setting for the 
Track. For more information about this, see the chapter “How Cubase handles au-
dio and MIDI” in the electronic documentation.

Continuous Messages

Pitch bend, AfterTouch and Controllers (like modulation wheel, sustain pedal, vol-
ume etc.) are considered as MIDI continuous Events (as opposed to the momentary 
key down and key up messages).

About recording Continuous Messages

If you move the Pitch Bend wheel on your synthesizer while recording, this move-
ment gets recorded together with the key (Note On and Note Off messages), just as 
you’d expect.

But the continuous messages can also be recorded after the notes have been re-
corded (or even before). They can also be recorded on Tracks separate from the 
notes they belong to. 

Say for instance that you record one or several bass Parts on Track 2. If you now set 
another Track, like Track 55, to the same Output and MIDI Channel as Track 2 you 
can make a separate recording of just Pitch Bends for the bass Parts. This means 
that you activate recording as usual and only move the Pitch Bend wheel during the 
take. As long as the two Tracks are set to the same Output and MIDI Channel it will 
appear as if the two recordings were made at the same time.

Program Change Messages

Normally, when you switch from one Program to another on your keyboard (or 
whatever you use to record), a number corresponding to that Program is sent out via 
MIDI as a Program Change message. These can be recorded on the fly with the mu-
sic, recorded afterwards on a separate Track, or manually entered in one of the Edit 
windows. You can also enter Program Change messages in the Inspector. 
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System Exclusive Messages

System Exclusive is a special type of MIDI message used to send things that only 
make sense to a unit of a certain make and type. Every major MIDI manufacturer 
has its own Sys Ex identity code. Sys Ex can be used to transmit a list of the num-
bers that make up the settings of one or more sounds in a synth. System Exclusive 
can be recorded just as any other messages and can be edited in List Edit.

This is discussed in more detail in the chapter “System Exclusive Handling” in the 
electronic documentation.

● You can prevent Cubase VST from recording certain types of MIDI data, by 
using the Input Filter function. This is described in the chapter “Filtering and 
Mapping MIDI data” in the electronic documentation.
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Recording Methods 8
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About Punch In and Out
Those of you who have used multi-track tape recorders know about a technique 
called Punching In. This is when you activate recording while the tape is rolling. If 
you for example have made a mistake in the middle of a chorus, you can play back 
from the beginning of the chorus and just before the flawed section, punch in and 
replace that section with a new performance.

Punch Out is when you deactivate recording without stopping playback. If – in the 
example above – the chorus is followed by a verse which is perfectly OK, you 
would punch out at the end of the chorus so that you don’t record anything on the 
verse.

In Cubase VST there are two ways to Punch In and Out: Manual and Automatic:

Automatic Punch In
1. Select a Track and set it up as necessary (as with any other recording).

2. If you are recording MIDI, decide if the new recording should replace 
what is currently on the Track (Replace mode) or if you want to add to it 
(Overdub mode).
This is done with the Rec Mode switch on the Transport Bar, as described in 
the previous chapter.

3. Set the Left Locator at the position where you want recording to be acti-
vated.

4. Move the Song Position to some point before the Left Locator.
This can for example be done by using the Transport buttons (Rewind, Fast 
Forward etc) or by changing the value in the Song Position box on the Trans-
port Bar. More info on page 103.

5. Click on the Punch In button on the Transport Bar so that it is activated.

Punch In activated.
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6. Activate playback.

Now, when the Song Position reaches the Left Locator, recording is automatically 
activated, as you can note by observing the Record button on the Transport Bar.

7. Record.

8. Terminate recording either by stopping or by Punching Out (see below).

1. Set the Song 
Position...

2. Activate playback...

3. When the program 
reaches the punch in 
point...

4. Recording is automatically activated!
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Manual Punch In
1. Select a Track and set it up as necessary (as with any other recording).

2. If you are recording MIDI, use the Rec Mode switch to decide whether 
the new recording should replace what is currently on the Track or add 
to it.

3. Make sure Automatic Punch In on the Transport bar is not activated.

4. Move the Song Position to some point before the position where you 
want to Punch In.

5. Activate playback.

6. When you reach the right position, click on the Record button or press 
[*] on the numeric key pad.

7. Record.

8. Terminate recording either by stopping or by Punching Out (see below).

About punching in on long notes

When you activate recording in Cubase VST, already recorded notes are never cut 
off, they will play to their end just as they did before you started this recording. 
This is true regardless of the Record mode chosen (Overdub or Replace).

About punching in on Controller or Pitch Bend data

Watch out when punching in and out on recordings with Pitch Bend or Controller 
data (modulation wheel, sustain pedal, volume etc), since this may lead to strange 
effects (hanging notes, constant vibrato etc). 

If you for instance punch out with the sustain pedal on your synthesizer down, you 
have instructed the program to keep the notes hanging, since the release of the 
pedal has not been recorded. During playback, Cubase VST may clean up Pitch 
Bend, Modulation and Damper pedal and Channel Pressure at the end of each Part, 
taking into account what happened in earlier Parts. But, the way Continuous MIDI 
messages behave is still something to be aware of.

Punch In deactivated.
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Automatic Punch Out
1. Set the Right Locator to the position where you want recording to be ter-

minated.

2. Click on the Punch Out button on the Transport Bar so that it is acti-
vated.

3. Now, recording is automatically deactivated when the Song Position 
reaches the Right Locator.

You can of course combine automatic Punch In and Out for a totally automated re-
cording.

The Right Locator positioned

Punch Out activated

Activate recording.

When the Song Position reaches the Right Locator...

Recording is automatically deactivated, 
but playback continues.
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Manual Punch Out
1. Activate recording in any way you like.

You might for example combine manual Punch In and Out to fix an error in 
an otherwise good performance.

2. When you reach the right position, click on the Record button or press 
[*] on the numeric key pad.

3. If you like, Punch in again and record some more.

4. When you’re done, Stop Cubase VST.
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About the Cycle
Cubase VST can play back and record in a Cycle – a loop. You decide where the 
Cycle starts and ends by setting the Left and Right Locators. When Cycle is active 
you can repeatedly listen to a section of the Arrangement, and record, adding more 
on each lap etc. Cycled playback is also convenient when editing and when making 
adjustments in the Inspector.

Setting up the Cycle

1. Set the Left Locator to the position where you want the Cycle to begin.

2. Set the Right Locator to the position where you want the Cycle to end.

3. Click on the Cycle button on the Transport Bar so that it gets activated, 
or press [÷]on the numeric key pad.
Set up the Left and Right Locator...

...and activate the Cycle.
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Playing back the Cycle

When you play back with Cycle activated, the section between the Locators gets re-
peated indefinitely.

You can use any and all functions while the program is playing back. This fact al-
lows you to use Cycled playback for a number of things, many of which you will 
learn about later in this manual:

• Rehearse a part before recording.
• Mute Tracks and Parts to try out variations on an Arrangement.
• Concentrate editing in the Audio and MIDI editors to a certain section of the 

Song.
• Make adjustments in the Inspector, apply Quantizing etc, to fine tune levels 

and grooves.
• Make settings in the Mixer, add EQ and Effects to Audio Parts.
• Make adjustments to the sounds in your MIDI instruments or try out a Track 

with another sound.
• etc, etc.
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Recording in Cycle Mode

● The basic Cycle recording procedure is the same for MIDI and Audio Tracks. 
However, the results are different, as described on page 91 in this chapter.

From the Left Locator

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on.

3. If you are recording MIDI, select a Record Mode (Overdub or Replace) 
with the switch on the Transport Bar.
This is described on page 78.

4. Click the Record button.

5. After the count-in, start playing.

6. Keep playing on each lap of the Cycle until you are satisfied.
If you are recording MIDI, see the Cycled Recording Modes and Functions 
described below.

7. Stop Cubase VST or punch out manually.

Cycle On/Off
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From Before the Cycle

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on and select a Record Mode (Overdub or Re-
place).

3. Activate automatic Punch In on the Transport Bar.

4. Set the Song Position to some point before the Cycle.

5. Activate playback.

When Cubase VST reaches the Cycle, recording is automatically activated.

6. Keep playing on each lap of the Cycle until you are satisfied.
See the Cycled Recording Modes and Functions described below.

7. Stop Cubase VST or punch out manually.

● If you Punch In manually before the Cycle, the Cycle is automatically turned 
off!

Punching In and Out in the Cycle

Once you are in the Cycle you can punch in and out manually as many times as you 
wish without stopping in between. Simply click the Record button or press [*].

Punch In activated.
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About Recording Audio in the Cycle
If you are recording Audio in Cycle mode, the following happens:

During the entire recording, only one Audio file is created. However, this is split up 
into a number of Segments (one for each lap) which are “stacked” in the Audio Ed-
itor. Since the Segments are all on the same Track, this normally means that only 
one of them will play back (the first “take” you recorded, since this is the top one in 
the Audio Editor). However, you can use this feature to assemble a “perfect” take 
from all the different Segments, by cutting out the best pieces of each Segment and 
putting them together. This is described in the chapter “The Audio Editor” in the 
electronic documentation.

• None of the Cycle modes and Functions used when recording MIDI (de-
scribed on the following pages) have any relevance to audio recording.
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About Recording MIDI in the Cycle
Basically, MIDI Cycle Recording can either be used to add new data for each lap 
(overdub) or replace previously recorded data. However, there are a lot of special 
modes and functions available when recording MIDI in the Cycle:

Switching Tracks while recording

You can record on more than one MIDI Track while in the Cycle:

1. Set up a few MIDI Tracks that you wish to record on. Also set up the in-
strument(s) so that they play the right sounds on these MIDI Channels.

A few Tracks set up for recording a four bar groove.

2. Enter recording in Cycle mode.
Record on the first Track.

3. Without stopping, select a new MIDI Track in the Track list or use the [↑ ] 
and [↓ ] keys to step through the Tracks.
Selecting a new Track set to a different MIDI Channel and maybe Output, au-
tomatically routes your playing to the new sound.

4. Record on this second Track as with the first.

5. Keep recording on different Tracks until you are satisfied.
See the Cycled Recording Modes and Functions described below.

6. Stop Cubase VST or punch out manually.

Recording Sys Ex data in the Cycle

There is nothing that prevents you from Cycled recording of Sys Ex data (see the 
chapter “System Exclusive Handling” in the electronic documentation), although 
this can lead to serious confusion. In plain English: don’t, if you’re not absolutely 
sure of what you are doing.
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Cycle Recording Modes

Switching Modes

On the Transport Bar you will find a small box labelled “Cycle Rec”. This is used to 
select one of three “behaviours” when recording in Cycle Mode.

You can select any of the modes prior to, or during, recording.

● As always when you record, the regular Record Mode switch (Overdub/Re-
place) determines what happens with any MIDI data that is already on the 
Track before you start Cycle Recording. For an explanation of the relation be-
tween the Record Mode and the Cycle Recording Mode, see page 97 in this 
chapter.

Mix Mode

In Mix mode, everything you record is added to what was recorded before. This is 
the preferred mode if you for example are building up a rhythm pattern in Cycle 
mode. You can start with the hi-hat, add bass drum on the second lap, snare on the 
third etc.

Punch Mode

In this mode Cubase VST automatically punches in the moment you play anything 
on a lap. Proceed as follows:

1. Select Punch Mode.

2. Start Recording in a Cycle.

3. If you make a mistake in the middle of the Cycle, simply wait until you 
reach the correct position on the next lap, and start playing again.
What was previously recorded from this point to the end of the Cycle is re-
placed with what you play now.

The Cycle Rec Mode Switch

Record some notes on the first lap...

Whatever you record on the 
following lap(s) is simply added 
to the existing notes
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4. When you have a recording you’re happy with, you can turn off Punch 
mode, Stop or Punch Out.

Normal Mode

The name Normal mode refers to the way Cubase VST behaves during normal (as 
opposed to Cycled) recording. This allows you to record afresh on the Track each 
time you enter the Cycle.

1. Decide if you want to overwrite earlier recordings on the Track or not, 
by selecting a Record Mode (Overdub or Replace).
See page 78.

2. Select Normal Cycled Recording Mode.

3. Record something on a lap.
You will not hear what you recorded, on the next lap(s).

4. If you’d like to redo the recording, simply try again on any upcoming lap.
Everything you recorded on earlier laps is automatically deleted.

5. When you have a performance you like (a complete recording on a lap), 
stop recording or switch to another Cycled Recording Mode.

● Please note: a complete lap is only kept when the recording is stopped some 
time during the next lap.

Record some notes on the first lap...

Whenever you start playing on an 
upcoming lap, your new recording 
will replace the notes from that 
point and onwards.

Record some notes on the first lap...

If you play anything on any of the 
upcoming laps, it will totally replace 
your earlier recording.
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Cycle Recording Functions

These functions are found on a pop-up menu that appears when you press the 
mouse button with the pointer over the “Cycle Rec” text on the Transport bar, while 
recording in Cycle mode.

Delete Last Version

If you just made a mistake on the last lap, proceed as follows:

• While recording, select Delete Last Version from the pop-up menu or 
press [V] on the computer keyboard. 

This erases your last recording. It doesn't matter if you didn't play anything for sev-
eral laps, the last lap that you recorded anything on is erased.

Delete Subtrack

If you make a mistake and don't wish to keep anything of what you've just recorded, 
proceed as follows:

• While recording, select Delete Subtrack or press [B] on the computer 
keyboard.

The Part is cleared (but not deleted) and you can instantly start inputting music 
again, without leaving Record mode.

Key Erase

To erase all notes played with a certain key, or keys, proceed as follows:

1. While recording, press and hold the relevant keys on the synth keyboard.

2. Select Key Erase from the pop-up menu or hold down [K] on the compu-
ter keyboard.
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Quantize Last Version

Quantizing is a function you can use to let the computer correct imprecisely played 
notes to the next correct timing position, defined by you. Quantizing is not irrevo-
cable, it can always be undone unless you specifically “freeze” your Quantize. Cu-
base VST provides several different Quantize options, described on page 208.

If you want to Quantize everything you recorded on the last lap, proceed as follows:

1. Select a Quantize note value by using the Quantize pop-up at the top of 
the Arrange window.

2. Select Quantize Last Version or press [N] on the computer keyboard. 

Just as with Delete Last Version, it doesn't matter if Cubase VST has played back 
the Cycle several times since you last played anything, the last lap you recorded an-
ything on is Quantized anyway.

The Quantize pop-up
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About Cycled MIDI Recording and the Overdub/Replace Switch

As described on page 78, the Overdub/Replace switch is used to decide if what you 
record now is added to whatever was on the Track before or whether it should re-
place the existing recordings.

The same is true for Cycled Recording:

• If Overdub is selected, everything you record is added to what was previously 
on the Track.

• If you select Replace mode, everything you record during one recording pass 
(the time from which you activate recording until you deactivate it again) re-
places what was previously on the Track.

• The Cycle recording Modes and Functions described on the previous pages 
only apply to what is recorded during one recording pass. For example, the 
special Cycle Punch Mode does not delete any notes recorded on the Track 
before, only notes that were recorded in the Cycle this time.
1. Let’s say you have a Part already 
recorded.

2. You activate Cycled recording in 
Overdub Mode to add more notes.

3. If you now use the Cycle 
Mode Punch function, you will 
only replace the notes recorded 
during the Cycle recording pass.
The previously recorded notes 
are not affected.
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About Multi Recording
For both audio and MIDI, Cubase VST allows you to record on several different 
channels or Tracks at the same time. There are several uses for this:

• You can record several players playing “live” at the same time.
For this to be possible with audio recording, you would need an audio card 
with at least as many separate inputs as there are players.

• You can record a MIDI instrument that transmits on several MIDI chan-
nels simultaneously.
In this case you could either simply record on one Track, and set the MIDI 
Channel to “Any”, in which mode the Track will play back each recorded 
Event on the MIDI Channel it was transmitted on. Or, you could use Multi 
Track recording, to automatically record different MIDI Channels on different 
Tracks.

• You can record MIDI and audio at the same time.
The “Any” Channel setting and the Multi Track Recording methods are de-
scribed in the chapters “How Cubase handles Audio and MIDI” and “Multi 
Track Recording” in the electronic documentation. 
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9

Playback, Tempo and the Transport 
Bar 9
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The Transport Bar
Below, you will find a brief description of what each control on the Transport Bar is 
used for:

Hiding and showing the Transport Bar

To hide the Transport Bar,  select “Hide Transport” on the Windows menu, or press 
[F12] on the computer keyboard. To bring it back, select “Show Transport” from 
the Windows menu or press [F12] again.

When the Transport Bar is hidden, you can still access all its functions via the com-
puter keyboard. See below for a list of Transport Bar key commands.

Moving the Transport Bar

You can put the Transport Bar anywhere you want it, by dragging the handles.

Activates Punch In

Switches between the 
three Cycle Recording 
modes (see page 93)

The Overdub/Replace switch 
(see page 78)

Punch Out point 
and end of Cycle

Record start point, Punch In 
point and beginning of Cycle

Cycle 
On/Off

Activates 
Punch Out

Handle
(move)

Song Position 
(Meter format)

Song Position 
(Time format)Position Slider

Rewind Fast Forward Stop Play Record

Indicates MIDI 
In/Out activity

Activates synchronization 
to other equipment

Tempo
Time Signature

Turns the Metronome 
On/Off

Turns the Master 
Track On/Off

Activates automatic 
quantization during record
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The Numeric Key Pad
The numeric part of the computer keyboard is used for many Transport Bar opera-
tions. Some of these are described in more detail later in this chapter.

In addition to this, the Page Up and Page Down keys function as Fast Forward and 
Rewind.

If you have a computer without a numeric key pad, some transport commands are 
still available from the regular keyboard (the picture shows American key caps):

The Space bar also functions as Stop button.

Num
Lock ÷ x –

7 8 9

4 5 6 +

1 2 3

0 , Enter

Record

Lower Tempo

Raise Tempo

Play

Cycle On/Off

Go to 

Go to 

Go To 

Go To 

Cue Point

last Stop

Left Locator

Right Locator

Stop

9 0 – =8

[ ]
Cycle On/Off PlayRecord
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Basic Tempo and Time Signature Handling

Transport Bar and Master Track Tempo

There is actuallya choice of two sources for Cubase VST’s tempo:

• When the song uses a steady tempo throughout, you can turn off the Master 
button and simply set the right tempo directly on the Transport Bar. The tempo 
can be adjusted at any time, even while playing back.

• When the song contains tempo changes, you need to use the Master Track, 
(which is Cubase VST’s tempo Track but also more!). For those tempo changes 
to actually “happen” on playback, the Master button on the Transport Bar 
must be activated. This is all discussed in the chapter “The Master Track” in 
the electronic documentation.

Setting the Transport Bar Tempo

The tempo on the Transport Bar is adjusted like any other value (see page 37 in this 
document). The value is in BPM (Beats Per Minute). The integer and fraction part 
can be adjusted separately, if needed.

The Tempo setting on the 
Transport Bar is used.

The Tempi set on the Master Track are 
used and shown on the Transport Bar.
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Setting the Song and Time Position

Using Fast Forward and Rewind

The Song Position can of course be moved using Fast Forward or Rewind. If you 
hold down [Shift] while clicking the button, Rewind/FF is much faster.

By double clicking in the Ruler

If you double click somewhere in the ruler, the Song Position Pointer is moved 
there.

By using the Position Slider

The position slider is located on the Transport Bar. Drag the handle or click directly 
somewhere on the line to move the handle there.

The range of the slider relates to the length of your Arrangement. This means that if 
you drag the slider all the way to the right, the Song Position will appear at the end 
of the last Part.

Dragging the Position Slider.

Rewind Fast Forward

Double-click in the ruler... ...to move the Song Position Pointer.
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About the Snap Value

When you change the Song Position in the ruler or by using the position slider, 
something called “the Snap value” helps you find exact positions quickly. It does 
this by limiting the possible points for positioning, to Bar, half note, quarter note, 
etc. Snap can of course also be set to Off.

The Snap value is set with the Snap pop-up at the top of the Arrange window.

Changing Position values on the Transport Bar

You can adjust the Meter or Time Position values on the Transport Bar, as described 
in the chapter “Basic Methods”. The Song pointer is moved accordingly.

Value Description

Off Any position can be used.

Bar Movement is restricted to exact bar lines.

1/4 to 1/16 Movement is restricted to the selected note value.

If Snap is set to Bar...

...Parts can only be dragged 
to exact bar lines.

If Snap is for example set to 1/4...

...Parts can be put on any 
quarter note position.
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Making relative Position changes

If you double click on either position value and enter a new one, preceded by a “+” 
or “–” character, the song position is moved relatively.

Returning to the beginning of the Song

If the Song is stopped and you click the Stop button again (or press [0] on the nu-
meric key pad), the following happens:

• The Song Position is moved to the Left Locator.
• If the Song Position is already at the Left Locator or to the left of it, the Song 

Position is moved to the beginning of the Song.

This means that you can always click twice on the Stop button to return to the be-
ginning of the Song.

Going to the left side of the window

If you press the [Home] key on the computer keyboard, the Song Position pointer is 
moved to the left side of the window.

Going to the last Stop Position

If you press [9] on the numeric key pad, the Song Position moves to the place you 
last stopped at.

...enter a value 
preceded by + or – ...

...and the value 
gets added to the 
existing position.

Double click...
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Moving to the Locators

• If you press [1] on the numeric key pad, the Song Position is moved to the Left 
Locator.

• If you press [2] on the numeric key pad, it is moved to the Right Locator.

Using Cue Points

Cue points are used to quickly locate to any position. If you for example often find 
yourself jumping to the beginning of the first chorus, set up that position as a cue 
point.

Programming Cue Points

1. Set the Song Position to where you want the Cue Point to be.

2. Hold down the [Shift] key and press any of the keys [3] to [8] on the nu-
meric key pad.
The key is now programmed with that position.

Locating to Cue Points

If you press any of the keys [3] to [8] on the numeric key pad, the Song Position is 
moved to the position programmed for that key.
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Cueing

● This feature only works with MIDI Tracks.

Cueing is when you fast forward through the music while playing it. You might 
have done this on a tape recorder. The big difference with Cueing in Cubase VST is 
that the music is played back with normal pitch.

1. Click and hold down the right mouse button with the pointer over the 
Fast Forward button.

2. To change the speed of cueing, drag the mouse left/right while keeping 
the mouse button pressed.
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Locators

Setting the Locators by clicking in the Ruler

1. Set the Snap value.
The Snap value restricts the positions you can move the Locator to, as with 
the Song position, see page 104.

2. Click somewhere in the ruler with the left mouse button, to move the 
Left Locator.
The Locator appears at that position. To move the Right Locator, click with the 
right mouse button.

Setting the Locators on the Transport Bar

You can also adjust the Left and Right Locator position by changing the numerical 
values in the Locator boxes on the Transport Bar.

Making relative Position changes

Just as with positions (see page 105 in this document) you can double click and en-
ter a new value, preceded by a “+” or “–” character. When you hit [Return] the Lo-
cator is moved relatively.

Setting the Locators by selecting Parts

You can adjust the Locator positions to the range of the currently selected Part(s).

1. Select the Part(s) by clicking on it/them.
If the range includes several Parts, hold down the [Shift] key while selecting.

2. Hold down the [Alt] and [Ctrl] keys and press [P].
The Locators are positioned around the selected “block”.

Click with the left mouse button... ...to position the Left Locator.
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Pre-programming Locator Pairs

If you find yourself moving the Locators back and forth between the same positions 
all the time, you can pre-program some Locator combinations for instant recall:

1. Set up the Locators as desired.

2. Hold down the [Shift] key on the computer keyboard.

3. Press one of the Function keys [F2] to [F11] on the computer keyboard.
That key is now programmed with the current settings of the Locators.

Recalling Locator Positions

• Press the desired function key ([F2] to [F11]).
The Locators are moved to the memorized positions.
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Using Time Positions in the Rulers
If you’d like to use Cubase VST as a time based program, rather than a meter 
(tempo) based one, you can change the position indicators in any window, as fol-
lows:

1. Locate the Mouse Position box.
In the Arrange window this is located on the Status Bar (the area directly 
above the ruler).

2. Click once in the box.
Now the ruler and the Mouse Position box change to show time positions in-
stead of meter positions.

3. To switch back to meter positions, click again.

● Please note that even though you have switched to time positions, Snap is still 
on and relates to meter positions. You might want to set Snap to “Off” when 
using time positions.

The Mouse Position boxMeter Positions

Time Positions
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Working in the Arrange window 10
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About Tracks, Parts and arranging
A Cubase VST Arrangement is roughly structured in three “levels”: Several Tracks, 
each containing a number of Parts which in their turn contain Events (audio record-
ings, MIDI notes, etc). This chapter is about Arrangement editing - in other words, 
the re-arranging of the larger building blocks, Parts and Tracks. This is done in the 
Track List and in the right part of the Arrange Window, the area called the Part Dis-
play.

An Arrangement with the Track List to the left and the Part Display to the right.

You can have up to 16 Arrangements in the same Song. How to create, open, close 
and set aside Arrangements is described on page 130.
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What can I do with Tracks?
The Track is one of the most basic concepts in Cubase VST. Every time you record 
something in Cubase VST, the recorded material is placed on a Track. You can have 
thousands of Tracks in each Arrange window, and you can easily move or copy ma-
terial between Tracks (if the Tracks are of the same kind - see Track Classes, page 
119).

The most obvious reason for putting the recorded material on different Tracks, is 
perhaps that you want to organize your music like an “ensemble” with one Track 
for each orchestral Part, or “musical instrument”. But there are also many other ad-
vantages of working with many Tracks.
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Creating Tracks
Create a new Track when you want to add another “layer” to your recording. You 
might for example want to add another “instrument”, or make room for an alternate 
version of a part in your music. There are several ways to create a new Track:

By using the Mouse

By using the Structure Menu

Selecting Create Track from the Structure menu will make a new Track appear at 
the bottom of the Track List. You may also use the keyboard short-cut [Control]-[T] 
to accomplish the same thing.

About Track Classes

As already mentioned, there are several different types of Tracks in Cubase VST. 
When you create a new Track, it will get the same Class as the previously selected 
Track, but you can change this later if you wish (see page 119).

Double clicking in an empty 
part of the Track List...

...creates a new Track.
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Naming Tracks
If you start with an empty Arrange Window (with no Tracks), and create a new 
Track, it gets the name “Track 1”. Next time you create a New Track, this gets the 
name “Track 2” and so on. You can rename a Track at any time, simply by double 
clicking on its current name in the Track List, and typing in a new name.

Selecting Tracks
If you want to record on a Track, change settings for it or perform an operation that 
affects a whole Track, the Track has to be selected for Cubase VST to “understand” 
which Track you wish to direct the action to. The selected Track is also called the 
“active Track”.

There are several ways to select a Track:

• Click in the name field of the Track you want to select.

• Use the [↑ ] and [↓ ] keys on the computer keyboard to select the Track 
above/below the currently selected.

• Press [Ctrl]+[Alt]-[T] on the computer keyboard, and type in the number 
of the Track you want to select (counted from the top of the Track List).

This Track is 
selected (active).
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Changing the order of the Tracks
You can rearrange the Tracks in the list like this:

● All the Parts on the Track are moved with the Track.

1. Press the mouse button with the pointer on the Track you want to 
move. The pointer takes on the shape of a hand.

2. Drag the Track with the mouse button pressed. A dotted outline 
shows you where the Track will be placed.

3. When you release the mouse button, the Track is moved to its 
new position.
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Duplicating Tracks
You may make a copy of a Track and all Parts on it. 

1. Position the pointer on the name of the Track in the Track List.

2. Hold down [Alt] on the computer keyboard and press the mouse button.

3. Drag the outline of the Track to an empty  field in the Track List.

4. Release the mouse button.

● You can not duplicate empty Tracks.

A duplicate of the selected Track is created and placed, 
complete with Parts, at the bottom of the Track List.
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Deleting Tracks
You may delete a Track and all Parts on it.

1. Make sure that no Part is selected, by clicking in some empty area in the 
Part Display.
This is to make sure that what you Delete will be a Track, not a Part. 

2. Press [Backspace] on the computer keyboard or select Delete Track on 
the Edit menu.

● If you change your mind, you can undo the Delete Track operation with the 
Undo option on the Edit menu, or by pressing [Control]-[Z] on the computer 
keyboard.

Check that this menu item 
says “Delete Track”, not 
Delete Parts.
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Track Classes
There are different types of Tracks, called classes. In the column marked “C” in the 
Track List, a small symbol shows which class each Track has. 

How to select a Class for a Track

Converting a Track from one Class to another

If you have not recorded anything yet on a Track, you may at any time convert it to 
any class. Just select the new class from the menu as described above. If there is 
something recorded on it you may not be able to select another class for the Track.

● In the rest of this manual, if nothing else is stated, an operation applies to all 
Track classes.

Press the mouse button with 
the pointer in the “C” 
column for a Track...

...to pull down a menu 
where you can select a 
Track Class.
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The Basic Track Classes

Audio Tracks Audio Tracks are used for recording and playing back 
audio.

MIDI Tracks MIDI Tracks are used for regular MIDI recording and 
editing.

Drum Tracks Just like MIDI Tracks, Drum Tracks contain MIDI Events, 
but Drum Tracks are tailor-made for use with the Drum 
editor. See the chapter “Drum Edit” in the electronic 
documentation.

Mix Tracks A Mix Track contains data for the MIDI Mixer, a win-
dow that lets you control the volumes and parameters 
on your connected MIDI devices, from inside Cubase 
VST. See the separate document “The MIDI Mixer and 
Mix Tracks”.

Group Tracks These are described in the chapter “Groups” in the 
electronic documentation.

Tape Tracks These are described in the separate document “Tape 
Tracks – Controlling Tape Recorders”.

Style Tracks These are available if you have installed the Style Tracks 
module, a device that lets you work with “Styles”, a 
kind of automated accompaniment pattern. See the sep-
arate document “Style Tracks”.

Chord Tracks Chord Tracks contain information about chord changes. 
These chords are used by the Style Tracks, and in the 
Score editor in Cubase VST Score.
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About Parts
Parts are the containers for your audio and MIDI recordings. The use of Parts in 
Cubase VST makes it easy to get a quick overview of the arrangement, and to 
move, duplicate or delete sections of music. On the following pages you find a 
number of functions for working with Parts in the Arrange window.

• For more informations about what you can do with Parts, see the chapter 
“The Arrangement-Working with Tracks and Parts” in the electronic doc-
umentation.

Creating Parts
Normally, Parts are created automatically when you record something, or when you 
drag or import files into the Arrange window (see page 153 and page 245). How-
ever, there are situations when you might want to create an empty Part, and then fill 
it with Events in an editor. There are several ways to do this:

• Select the Pencil tool and draw a Part.
The length of the Part is restricted by the Snap value (see page 104).

• Set the Left and Right Locators to where you want the Part to start and 
end, pull down the Structure menu and select “Create Parts”.
A Part is created on the active Track, between the Locators. 

• Double click with the arrow pointer between the Left and Right Locator.
A Part is created on the Track where you clicked, between the Locators. 

Naming Parts
When you record a Part, it gets the name of the Track. You can rename a Part at any 
time, using one of the following methods:

• Select the Part, open the Inspector and double click on the name field.
Type in a new name and press [Return].

• Hold down [Alt] on the computer keyboard and click on the Part.
A small name value box opens, where you can type in a new name. 

● For the name to be displayed in the Part, you need to have the option “Show 
Names” or “Show Names and Waves” selected on the Part Appearance sub-
menu on the Options menu (see page 128).
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Selecting Parts
As with all elements in Cubase VST, you have to select a Part to be able to move, 
delete or in any way manipulate it. Selecting a Part can be done in several different 
ways:

• By clicking.
Clicking on a Part with the Arrow tool selects it, and deselects all other se-
lected Parts.

• By shift-clicking.
If you hold down Shift and click on a Part, it is selected, but all previously se-
lected Parts remain selected as well.

• By using the computer keyboard.
If a Part is already selected you can press the right arrow key on the computer 
keyboard to select the next Part on the same Track. The left arrow key selects 
the previous Part on the Track.

• By enclosing Parts in a rectangle.
Click somewhere in an empty area of the Part Display and drag the mouse 
with the button pressed. A dotted rectangle outline is shown.

When you release the mouse button, all Parts that were enclosed or 
“touched” by the rectangle, become selected.

If you hold down [Shift] when you start to drag, you don’t have to point at an 
empty area, you can start with the pointer positioned over a Part.
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Selecting Parts using the Edit menu

On the Edit menu you will find an item called “Select” which brings up a sub-menu 
with a number of options that allow you to select all Parts on a Track, all Parts in the 
Arrangement, to invert the current selection etc (see the Online help for a complete 
description of the menu selection options).

•You can also select all Parts by pressing [Control]-[A] on the computer key-
board.

•You can also select all Parts on a Track, by holding down [Shift] and double 
clicking anywhere on that Track.

Deselecting Parts

There are two principal ways to deselect already selected Parts:

• If you click in some empty area of the Part Display, all selected Parts get 
deselected.

• If you hold down [Shift] and click on a selected Part, only this Part gets 
deselected.
The other selected Parts remain selected.
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Manipulating Parts

● When you are moving, duplicating or changing the length of Parts, the result 
of your actions depends on the Snap value, just as when moving the Song Po-
sition or the Locators (see page 104). 

Moving Parts

You can move one or more Parts to a new position on any Track. Remember that the 
Snap value determines where you can place the Parts.

Duplicating Parts

To duplicate Parts, proceed exactly as when moving, but hold down the [Alt] key on 
the computer keyboard when you are dragging the Parts. You may move the dupli-
cate to any position on any Track.

Other ways of duplicating Parts is to use the Repeat function, or Cut/Copy and 
Paste. These functions are described in the chapter “The Arrangement – Part and 
Track Operations” in the electronic documentation.

Press the mouse button with the pointer over the selected Parts 
you want to move. The pointer takes on the shape of a hand.

Drag the Parts to their new position...

...and release the mouse button. The Parts are moved. Note that 
the relative distances between the moved Parts are kept intact.
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Changing the length of a Part

You can change the length of a Part in the following way:

1. Select the Pencil tool from the Toolbox.

2. Click on the outline of a Part and drag the outline to set a new length.

● If you make a MIDI Part shorter, all Events in the removed section of the Part 
will be erased!

Splitting a Part

You can use the Scissors tool to split a Part in two:

1. Select the Scissors tool.

2. Click on the Part.
The Part is split in two, at the position where you clicked (taking the Snap 
value into account). The two Parts will have the same name as the original 
Part.
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Joining two Parts

Just as you can split a Part in two, you can use the Glue Tube tool to “glue together” 
two Parts. The two Parts do not have to touch one another:

1. Select the Glue Tube tool.

2. Click on the first Part.
The Part is joined to the next Part on the Track. The resulting, longer Part will 
have the name of the first Part.

• If you hold down [Alt] and click on a Part with the Glue Tube tool, all the 
consecutive Parts on the Track will be joined into one.

Monitoring the contents of a Part

With the Magnifying Glass tool, you can perform what is known as “Scrubbing”. 
This means that you can listen to the contents of each Part separately in Stop mode:

1. Select the Magnifying Glass.
From there on, the procedure differs for Audio Parts and MIDI Parts:

2. To monitor the contents of an Audio Part, click anywhere in the Part.
You will hear the contents of the Part played back, from the point where you 
clicked, for as long as you keep the mouse button pressed (or until the end of 
the Part).

When you press the mouse button, the pointer takes on the shape of a speaker.

3. To monitor the contents of a MIDI Part, drag the pointer forwards or 
backwards over the Part.
Notes and other MIDI Events will be played back according to how fast you 
drag the pointer.
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Deleting Parts
There are several ways to get rid of unwanted Parts.

• Select them and press [Backspace] on the computer keyboard.

• Select them and use Delete Parts on the Edit menu.

• Click on the Parts with the Eraser tool.
If you hold down [Alt] when you click, the Part and all the consecutive Parts on the 
Track will be deleted.

● Deleting an Audio Part will not erase the actual audio file or the segment in 
the Pool! 
To delete an Audio Part and erase the corresponding audio file from the hard 
disk, select the Part, hold down [Control] and press [Backspace].
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Part Appearance and Color
By using the Part Appearance submenu on the Options menu, you can choose how 
the Parts should be displayed in the Part display. The setting is global for all Ar-
rangements in the Song.

There are four options: 

• Show Names.
The Parts are displayed as boxes with the Part names.

• Show Events.
Each Part is displayed as a box containing a graphical representation of the Events 
in the Part. For MIDI Parts, you may define which types of Events should be dis-
played, by turning on and off the flags in the Part Appearance sub menu.

Events shown in Audio Parts and MIDI Parts.

• Show Frames.
The Parts are displayed as empty boxes.

• Show Names and Waves.
MIDI Parts are shown as boxes with the Part names; Audio Parts are shown 
with names and a representation of the audio waveform.
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Part Color

To distinguish Parts, you may give them different colors. You have a choice of 16 
user definable colors.

Adding Color to all Parts on a Track

1. Make sure no Parts are selected.

2. Select the Track in the Track list.

3. Select the desired color from the Part Color pop-up.

Adding Color to some Parts

1. Select the Parts.

2. Select the desired color from the Part Color pop-up.

Selecting different colors for different Parts can be very useful if you want to edit 
several Parts in a MIDI Editor. As described in the chapter “The Midi Editors-Gen-
eral Information” in the electronic documentation, you can then choose to display 
the Events in the color of their respective Part, making it easier to distinguish the 
different Parts.

The Part Color pop-up is found 
above the Part Display.

Choosing one of the colors from the 
menu adds color to the Parts.

Click here to edit the 
colors and names.
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Managing the Arrangements
As stated earlier, you can have up to 16 Arrangements in one Song. This section de-
scribes some functions used to handle Arrangements.

Creating a new Arrangement

You create a new Arrangement by pulling down the File menu and selecting “New 
Arrangement”, or by pressing [Control]-[N] on the computer keyboard.

Naming an Arrangement

To keep track of the different Arrangements in a Song, you can give names to each. 
Click with the right mouse button with the pointer over the current Arrangement 
name (to the left in the Arrange window’s Title bar), and type in a new name.

• If you choose to save an Arrangement to disk as a separate file, then the 
name you give it while saving will be used as the Arrangement’s title next 
time you load it.

Activating an Arrange Window

Normally, if you want to work in the Arrange window, you click on it to activate the 
window and bring it to front. However, if you have a lot of Arrangements in your 
Song, some of them might be obscured and impossible to activate this way. Then 
you can use the following method instead:

1. Pull down the Windows menu.
At the bottom of the menu, you find a popup with all Arrangements in the 
Song:

2. Select the desired Arrangement from the list.
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Saving and Opening Arrangements

The basic file format for Cubase VST is the Song file, but you can also save and 
open Arrangements separately, using the “Save As” and “Open” commands on the 
File menu. This makes it possible to transfer recordings from one Song to another: 
Save the Arrangement containing the recordings, open the other Song and open the 
Arrangement you saved.

• Read more about Saving and Opening in page 237.

Closing an Arrangement

If you select Close on the File menu, press [Control]-[W] or click on the window’s 
Close button, the following alert message will appear:

Select one of the following options:

• Yes.
Opens a file dialog where you can save the Arrangement for later use. After 
saving, the Arrangement is closed.

• No.
Closes the Arrangement without saving it.

• Set Aside.
The window is closed, but the Arrangement is kept ,“hidden” in the Song. To 
open a Set Aside Arrangement, pull down the Windows menu and select it 
from the Arrangement popup menu there.

• Cancel.
Cancels the operation, i.e. the Arrangement is not closed.

● Please note that there is no “Close Song” command! Even if you close all Ar-
rangements, the Song is still there. To create a new Song, use the “New Song” 
command on the File menu.
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The Track Columns and the Inspector11
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The Track Columns
The Track columns show names and settings for the Tracks. These settings can be 
changed directly. The headings are the same for all Tracks, but may have a slightly 
different meaning for different Track classes. Not all columns apply to all Track 
classes.

Getting the Track Columns to appear

The Arrange Window is divided into two parts, the Track columns to the left and 
the Part display to the right. To get all of the Track columns to appear, press the 
mouse button with the pointer positioned above the Divider (the border between the 
two parts of the Arrange Window) and drag it as far to the right as possible. You 
should now be able to see all of the Track columns.

Changing the order of the Track Columns

You can arrange the vertical columns in any order you like, by simply dragging the 
headings to the left and right, respectively.

If you drag to the left, the column will be inserted to the left of the column you 
"drop it on". If you drag to the right it will be inserted to the right of the column you 
"drop it on".

The Divider, dragged as 
far right as possible.



- 134 - 

The Activity Column

This column is only shown if the checkbox “Activity Display” in the Preferences 
dialog (reached from the File menu) is activated. The column, with the heading 
“A”, shows if any MIDI/audio is being sent out from the Track at the moment. The 
width of each bar represents velocity for notes. The activity column applies to Au-
dio Tracks, MIDI Tracks, Drum Tracks, and Group Tracks.

The Activity Column as it looks when notes are played back.

● This column cannot be moved!

The Mute Column

The Mute column is indicated by an “M”. By clicking in this column, you tempo-
rarily “silence” the Track. A black dot is displayed in the column. To make the 
Track sound again, you just click in the Mute column again.

Click in the "M" column...

...to Mute the Track. The black dot 
indicates that a Track is Muted.
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The Solo function

If you click on the Solo button in the upper left corner of the Arrange window (or 
press [S] on the computer keyboard), all Tracks except the selected are Muted. This 
is useful if you want to listen closely to the contents of a Track, and don’t want any 
other music to interfere.

• You can unmute one or more Tracks while in Solo mode if you want to 
hear, for example, just how two or three Tracks sound together.

• When you deactivate Solo, all Tracks will return to the Mute status they 
had before Solo was activated.

• If any MIDI notes are sounding at the moment their Tracks are Muted, 
they are allowed to play until their end.

• It is also possible to Mute single Parts, using the Mute tool.
This is described in the chapter “The Arrangement - More on what you can do 
with Parts and Tracks” in the electronic documentation.

About the “M” sign in the Mute column

For Audio Tracks, the Mute column serves a second purpose: when monitoring is 
activated for a Track, an “M” is displayed in its Mute column. This is only an indi-
cation; you cannot change the monitoring status by clicking in the column. The 
Mute function works as usual, regardless of the monitoring status.

The highlighted Solo button 
indicates that Solo is 
activated.

All Tracks except the 
currently selected, get 
Muted.
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The Class Column

This column is indicated by a “C” and is used to set a Track to a certain Class. See 
page 119 for a thorough explanation.

The Time Lock Column

This column is indicated by at "T". If you click in it, a lock symbol will appear, 
meaning that Events on the Track are fixed in time. The uses for this are explained 
in detail in the chapter “Time Locked Tracks” in the electronic documentation. 
Normally, you should make sure that no Track is Time Locked.

The Track Column

This column shows the Track's name. To enter or change a name, double click in 
this field for the relevant Track.

The Chn Column

The Chn column shows the Audio/MIDI Channel for each Track. You may change 
the channel of a Track at any time. For a full explanation of Audio/MIDI Channels 
and the effect of changing them, see the chapter “How Cubase handles audio and 
MIDI” in the electronic documentation. To avoid confusion, please take your time 
and read that chapter.

● The Chn column has different functions for Chord Tracks and Tape Tracks (see 
the separate documents about Styles and Tape Tracks, respectively). The col-
umn is not used at all for Style Tracks, Mix Tracks or Group Tracks.

A Time Locked Track.
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The Output Column

For MIDI and Drum Tracks, the Output column shows which physical MIDI Output 
each Track uses (see the chapter “How Cubase handles Audio and MIDI”). For Au-
dio Tracks, this column will always show the word “VST”.

• If you hold down [Control] while you change the Output value, all Tracks 
will get the selected Output value.

● The function of the Output column for Mix Tracks is described in the chapter 
“The MIDI Mixer and Mix Tracks” in the electronic documentation. The func-
tion of the column for Chord Tracks is described in the separate document 
about Styles. 
The column is not used at all for Style Tracks, Tape Tracks or Group Tracks.

The Instrument Column

In Cubase VST terms, an Instrument is simply a certain MIDI Channel together 
with a certain Output. Instruments can be defined for MIDI Tracks and Drum 
Tracks.

Defining your different MIDI Channel/Output combinations as Instruments can be 
practical, since you can do this once and then not have to check the actual Channel 
and Output settings. The concept is more thoroughly explained in the Instruments 
chapter in the electronic documentation.

To change Output for a MIDI Track, position the pointer in its 
Output column, press the mouse button...

...and select the MIDI Output you want 
from the pop-up menu that appears.
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Using the Inspector

● The information in this section is mostly relevant to MIDI Tracks/Parts only. 
For Audio Tracks, the Inspector is mainly used to set up the Tracks for record-
ing, as described on page 62.

What is the Inspector?

The Inspector is a part of the Arrange Window. It contains a number of value- and 
name fields, where you can change settings and properties of a Track or individual 
Parts on a Track. 
There is one important thing to remember before you start working with the Inspec-
tor:

● The settings you make in the Inspector will affect the material during play-
back. You do not really change anything recorded.

This also means that Inspector settings, such as transposition, are not shown when 
you edit a Part. To make these settings permanent you need to use the Freeze Play 
Parameter item on the Functions menu, as described on page 147.

When you play back notes from a Part...

...they pass through the Inspector...

...and are output, in this 
example transposed one fifth 
(i.e. seven semitones) upward.

The actual recorded material in the Part is not affected.
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Getting the Inspector to appear

You open the Inspector by clicking on the strip with the little Inspector Icon below 
the Track column, or by pressing [Alt]+[Ctrl]-[I]. An area to the left of the leftmost 
column in the Track list appears. In this you find a number of value fields, name 
fields and buttons, described in the following pages.

• To close the Inspector, click on the Inspector Icon again.

...to open the Inspector.

Click on the Inspector Icon...
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Changing values in the Inspector

By changing values in the Inspector, you make changes to your Parts and Tracks. 
Some fields are duplicates of fields in the Track list, Audio Monitor Mixer or GM/
GS/XG Editor, while others can be found only in the Inspector. To get a basic grip 
of how to use the Inspector, follow the steps below:

1. Open the Inspector.

2. Select a MIDI Track on which you have recorded some music.

3. Check that no Parts are selected.
The heading of the Inspector should read “Trackinfo” - otherwise, just click on 
an empty area in the Part Display.

4. Start playback.

5. While the music is playing, try changing the "Transpose" and "Volume" 
values in the Inspector.
The transposition and volume of the played back music will change accord-
ingly.

Making Real-time changes with the Inspector

When you change the value of a parameter in the Inspector, the new value is imme-
diately sent out to the MIDI Output. This will affect not only the sound source as-
signed to the selected Track, but all MIDI devices connected to the same Output as 
the Track, and set to receive on the same MIDI Channel.

You may use this feature for setting appropriate values (e.g. volume, velocity etc) 
while the music is playing.
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What is affected by the Inspector?
This depends on what is selected in the Arrange window. The following possibili-
ties exist:

When a Track, but not a Part, is selected

When no Parts are selected, the Inspector has the heading “Trackinfo”. The param-
eter values affect the selected Track, and all the recorded material (the Parts) on it.

The Inspector opened for the Track “Bass”.

One Part is selected

The Inspector has the heading "Partinfo". The parameter values affect the selected 
Part only.

The Inspector opened for the Part ”Bass verse”.

Two or more Parts are selected

The Inspector has the heading "Partinfo", and shows the parameter values of one of 
the selected Parts. If you change a parameter, you will get the question “Copy value 
to all selected Parts?”. If you click “Yes”, all the selected Parts will get the new 
value, regardless of their previous settings. If you click “No”, the change only af-
fects the Part whose values were shown in the Inspector.
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How MIDI Part and Track settings relate

As you have seen, you may change parameter values both for the whole Track and 
for individual Parts on the Track. It is the latest change that “counts”. If you for ex-
ample change the velocity value of a single Part and then set another velocity value 
for the whole Track, the Part will also get this latest velocity value. Other parameter 
settings for the Part will remain unaffected.

Make various settings for a Part... ...then change the velocity 
value for the whole Track.

Now the velocity value for the Part is changed to that of the 
Track, but the other settings for the Part remain unaffected.
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The Fields and values in the Inspector
The Inspector contains names, numerical values and pop-up menus. All these set-
tings can be changed using any combination of mouse and keyboard, as usual. Like 
all other changes, these can of course be done while the music is playing and even 
while recording.

The tables below contain the different parameters in the Inspector for Audio and 
MIDI Tracks/Parts, respectively. For other Track classes, the contents of the Inspec-
tor may differ. For a more thorough explanation of some of these parameters, see 
the chapter “Inspector Real Time Parameters” in the electronic documentation.

Audio Parts/Tracks (Mono or Stereo)

Parameter Explanation

Track/Part Name If a Track is selected, this shows the Track’s name. If a Part is 
selected, this displays the name of the Part.

Delay Delays the playback of the Audio Track/Part. With a negative 
value, Delay will cause the Audio Events to play earlier in-
stead.

Chan The audio channel the Track uses, as described on page 61. 
For Tracks set to stereo, both channels in the stereo pair are 
shown (e.g. “3+4”).

Input button This is a duplicate of the Input button for the audio channel 
in the Monitor mixer window. 
Clicking this button activates monitoring for the channel, 
while holding down [Control] and clicking allows you to se-
lect an Input for the channel. See page 64.

FX/EQ buttons These are duplicates of the FX/EQ buttons for the audio 
channel in the Monitor mixer window. See page 222.

Record Info Shows the name of the audio file currently assigned for the 
recording.

Record Enable but-
ton

Click this button to enable recording on the Track.

Mono/Stereo button This is used to select whether the Track should be set to Ste-
reo or Mono. The label on the button indicates which mode 
is currently selected for the Track. A lit up button indicates 
that it is possible to switch mode (see page 63).
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Audio Parts/Tracks (“any” channel)

If the Track or Part is set to audio channel “any”, the Inspector appears different. 
There are no FX/EQ buttons, and the Input and Record Enable buttons are replaced 
by a number of Monitor and Record Info buttons, one for each audio channel.

The “any” channel concept is described in the electronic documentation.

MIDI Parts/Tracks

Parameter Explanation

Track/Part Name The name of the selected Track or Part.

Instrument The Instrument (Output and Channel) that the selected Track or 
Part is assigned to.

Output The Output port for the selected Track or Part.

Chan The MIDI Channel set for the Track or Part.

Patch If you are using a soundcard with a built-in synthesizer that 
supports SoundFonts (such as the Creative Labs AWE series) 
you can use this field to select sounds for the synthesizer (see 
the chapter “Program Change and MIDI Volume” in the elec-
tronic documentation).

Bank Lets you associate a MIDI Bank Select message with a Track or 
a Part, to make an instrument switch "program bank" (see the 
chapter “Program Change and MIDI Volume” in the electronic 
documentation).

Prg Lets you associate a MIDI Program Change number with a 
Track or a Part, to make a connected instrument switch sound. 
If GM, GS or XG Mode is activated in the GM/GS/XG Editor, 
clicking this field will open a hierarchical pop-up menu, where 
you can select a GM instrument by name.
If you are using the Studio Module, Program selection is done 
differently - see the separate Studio Module documentation.

Volume A volume value for a Track or a Part. This setting is sent out as 
a MIDI Volume message.

Transp Lets you transpose the notes in a Part or on a whole Track.
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Veloc The value in this field is added to the velocity of the notes 
played back.

Delay Delays the notes. With a negative value, Delay will cause notes 
to play earlier instead.

Length Changes the note length by a percentage factor.

Compr Compresses/expands the velocity range of notes. This is done 
by multiplying the velocities with a percentage factor (25% - 
200%). 
If for example you want to “even out” a Part with varying ve-
locity values, you could select a “Compr” value of 25, 50 or 
75%. The smaller the value, the lesser the velocity difference 
between notes. To compensate for the decrease in velocity, you 
may want to add a positive value in the “Veloc” field.
In a similar way, “Compr” values greater than 100% will make 
velocity differences greater.

Pan Sends out a MIDI message, telling your instrument to place the 
sound of the Part/Track in a certain position in the stereo field.

Parameter Explanation
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When should I use the Track Columns and when should 
I use the Inspector?

Many of the parameters in the Inspector have equivalents in the Track columns. Re-
member the following facts:

• The Inspector can affect both Tracks and single Parts. The Track columns only 
affect whole Tracks.

• The fields with the same name in the Track columns and the Inspector have 
exactly the same function. Changing the value in one affects the other as well.

Why then use the Track columns at all? Well, for one thing, it is very handy to have 
instant overview and control over all Tracks at the same time. The contents of the 
Inspector will change depending on which Parts you have selected. There may also 
be situations when you want the Part display (to the right in the Arrange Window) 
as large as possible, and therefore need to close the Inspector.
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Using Freeze Play Parameters
As already mentioned, the Inspector settings (or “Play Parameters”) do not change 
the MIDI Events themselves, but work rather like a “filter”, affecting the music on 
playback. However, sometimes you may want to make these settings permanent, 
i.e. convert them to “real” MIDI Events in the Part. You might for example want to 
transpose a Part and then edit the transposed notes in a MIDI editor. For this, you 
need to use the Freeze Play Parameters item on the Functions menu:

1. Select the Part(s) with Inspector settings you want to make permanent.
If no Parts are selected, all Parts on the active Track will be affected.

2. Pull down the Functions menu and select “Freeze Play Parameters”.
Bank Select, Program Change, Patch, Volume and Pan settings in the Inspec-
tor will be converted to MIDI Events and inserted at the beginning of the 
Part(s). All notes in the Part(s) will be modified according to the Transpose, 
Velocity, Delay, Length and Compression settings in the Inspector, and the In-
spector settings will be reset.

● When you export a MIDI file, you can choose to have all Inspector settings 
automatically included in the file, with no need to perform Freeze Play Pa-
rameters: 
Before exporting, select “Preferences” from the File dialog and make sure that 
the checkbox “Leave MIDI File Track Data as is” is not activated! Then export 
the MIDI file, as described on page 244.
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Real-time Thru
In most MIDI recording situations, the Thru function in Cubase VST is used to 
“echo” incoming MIDI data via MIDI Out. If you use the Thru function, the MIDI 
data that Cubase VST receives via MIDI In is modified in real-time by some of the 
Playback parameters. This means that if you for instance set a transposition value 
of 7 (semitones) and play your keyboard, all notes coming out via the MIDI Out are 
transposed a perfect fifth higher.

This allows you to try out what effect a certain parameter setting will have on the 
music, before and when you record something. Since different Parts can have dif-
ferent settings you must select the right Track and check that the Song Position is 
somewhere within the Part that has the settings you want to try. 

● It doesn’t matter which Part or Track you have visible in Part Info (you may 
have stepped through the Parts and Tracks with the arrow keys on the compu-
ter keyboard), it is only the Song Position and Active Track which determines 
which Part’s settings should be used for the real-time modification. 

The real-time parameters used for modification are: Transpose, Velocity and Com-
pression.

You can also thru-put to up to four Instruments (Outputs and MIDI Channels), see 
the chapter “Multi Track Recording” in the electronic documentation.

Notes from the keyboard...

...are passed through the 
Inspector...

...and output again, 
transposed one fifth upward.

The Part in the "cross" made up by the 
Active Track and the Song Position is 
used for real-time "Thruing".
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Using the Pool 12
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What is the Pool?

Every time you record on an Audio Track, a file is created on your hard disk. This 
file is also added to the Pool, a window listing all audio files used in the Song. The 
way the Pool displays Cubase VST audio files and their contents is similar to the 
way the Windows Explorer displays lists of files and folders.

But Cubase VST is not restricted to playing complete files. It can also play any sec-
tion of a file from the beginning, at the end, or some snippet in the middle, short or 
long, it doesn’t matter. A specification for such a section of a file is called a seg-
ment. For each file that is used in the Song there will be at least one segment. There 
can be more. For example, different sections of an audio file might be used in more 
than one place in the song. All the segments are listed in the Pool.

• Read more about files and segments in the chapter “How Cubase VST 
handles Audio and MIDI” in the electronic documentation.

This chapter describes the basic techniques and information related to the Pool. In 
the electronic documentation you will find a lot more information.

This Audio File has four segments, playing different sections of the file.

The number to the left of the name, shows how many 
times each segment is used in the Song.
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Opening the Pool
The Pool is opened by selecting “Pool...” from the Audio menu or by pressing 
[Control]-[F].

How files and segments are displayed

Files

Each file is represented by a line in bold text, preceded by a triangle. For each file 
there are a number of settings and information, described in the chapter “The Audio 
Pool” in the electronic documentation.

Renaming a file

You can rename an audio file by double clicking on its name in the Pool and typing 
in a new name. This method makes it possible for Cubase VST to keep track of the 
name change. Renaming audio files in the Explorer or from the Desktop is not rec-
ommended.

Segments

Each file that is in use, has one or more segments, listed below the file in the Pool. 
The segments have their own settings, described in the chapter “The Audio Pool” in 
the electronic documentation. 

To display or hide the segments for one audio file, you click on the triangle preced-
ing the file.

• To Show/Hide all segments for all files, select Expand/Collapse from the 
pop-up View menu.
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Auditioning a segment

To audition a segment from its beginning, press and hold the mouse button with the 
pointer over the speaker icon to the left of the segment name. The segment will be 
played back in its entire length (or for as long as you hold down the mouse button).

If you don’t wish to audition the segment from its beginning, you can click any-
where in the waveform image to the right. The segment will play back from the po-
sition where you clicked, for as long as you keep the mouse button pressed.

Finding Out how a Segment is used in the Song

Next to the speaker icon for each segment, you will see a number telling how many 
times in the Song this segment is used. A segment without numbers is not used an-
ywhere.
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Dragging from the Pool to the Arrange window
One of the most important features in the Pool, is the possibility to drag segments 
into the Arrange window. This example makes use of the Quick Start Song included 
on the CD-ROM:

1. If you haven’t already copied the Quick Start Song folder to your hard 
disk, do this now.
See page 24.

2. Open the Song “Quick Start Song”.

3. Select New Arrangement from the File menu so that you get a new empty 
Arrangement.
In this example you will not use the original Arrangement, even though it will 
still be there in the background. ´

4. Make sure you have a number of Audio Tracks at the top of the Arrange-
ment.

5. Set the tempo of the Arrangement to 70 BPM.

6. Pull down the Audio menu and select Pool.
A Pool window with a large number of audio files in it is displayed.

7. Resize and arrange the windows so that you can see the first eight Tracks 
in the Arrangement, as much as possible of the Part Display and as much 
as possible of the Pool window.

8. In the Pool window, select Expand from the pop-up View menu.

9. Now, below each file appears one or several segments.
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10.Position the mouse pointer over one of the segment names, and press 
the button. With the mouse button down, drag the segment onto an Au-
dio Track in the Arrangement.
The picture sequence below shows this step in more detail.

1. Point at the 
Segment name

2. Drag onto an audio Track in 
the Arrangement

3. The Segment appears as a 
Part in the Part Display
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11.If the Part doesn’t appear at the place you intended, simply drag it to the 
right Track and bar position.
As always in the Arrangement, the Snap value affects where the segment is 
positioned.

12.Play back to hear the new Arrangement.

13.Drag another segment to another Track, and position it so that they start 
at the same time. Play back to hear the results.

14.Continue like this to add more Parts to build an Arrangement.

Two tips:

• Remember that you can repeat Parts that are already in the Arrange-
ment. 
This might be faster than dragging the same segment from the Pool many 
times.

• Use the Cycle function to try out different files and see if they go well to-
gether.
The Cycle function makes the section between the Left and Right Locator re-
peat over and over again. Just place the Left and Right Locators where you 
want them, click on the Cycle button on the Transport Bar so that it is lit, and 
activate playback. Then drag files to positions inside the Cycle while the pro-
gram is playing back!

The Cycle button.
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Importing Files into the Pool
If you have any other audio file on your hard disk, and would like to use it in the 
song, you can import it into the Pool and then drag it into the Arrangement, as de-
scribed above.

File Specifications

The Audio file must meet the following specifications:

• It must be in Wave (.WAV, most common on PC computers) or AIFF (.AIF, Au-
dio Interchange File Format, most common on Macintosh computers) format.

• It must be an uncompressed 16 bit file.
• The sample rate (also called sampling frequency) of the file must be the same 

as the one used in the Song (see page 59).
• The file can be mono or stereo.

Importing the file

1. Activate the Pool window.

2. Select Import Audio from the pop-up File menu.

A regular file dialog appears.

3. Select a file format (WAV, AIF or both) from the File Type pop-up.
Files of the selected type(s) are listed in the file dialog box.

4. Use the file dialog box to locate the file and select it.

• You can audition the audio file with the Play button.
When you click the Play button, its label changes to “Stop” and the selected 
audio file is played back. Playback continues until you click on Stop, or select 
another file.

• You can select several files by using the [Shift] or [Control] keys, in 
standard Windows fashion.

5. Click “Open”.
Now, the File(s) will appear at the bottom of the Pool window, each complete 
with a segment which can be dragged into the Arrangement (see above).

• Please note that you can also import audio files directly into the Arrange-
ment, using the “Import Audio File” item on the File menu (see the elec-
tronic documentation for details).
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Introduction
There are several ways to edit audio recordings in Cubase VST: 

• By manipulating Audio Parts in the Arrange window.
• By changing file and segment settings in the Audio Pool (see the Audio Pool 

chapter in the electronic documentation).
• By editing and trimming the Audio Events in the Audio Editor.
• By applying permanent editing and processing the actual audio files and seg-

ments in the Wave Editor (described in the Wave Editor chapter in the elec-
tronic documentation).

This chapter describes the basic features and techniques in the Audio Editor. For 
more detailed information, see the Audio Editor chapter in the electronic documen-
tation.

About Segments, Events, Parts and Non-destructive 
editing

As already mentioned, an audio segment is a section of an audio file. Basically, 
each segment consists of a reference to an audio file, a start point and an end point 
(called Start and End Insets from now on).

An Audio Event can be viewed as a “box” containing a segment (together with 
some additional settings). The Audio Part, in turn, is a “box” containing one or sev-
eral Audio Events (just like MIDI Parts contain notes or other MIDI Events).

When you edit an Audio Part in the Audio Editor, you do not change the actual re-
cording (i.e. the audio file), but rather the properties of the segment(s) and Audio 
Event(s) in the Part. The editing you perform is non-destructive, meaning that no 
audio data is lost. You can always change the settings back to the way they were be-
fore you started editing.
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Opening the Audio editor
To open the Audio editor, proceed as follows:

• Double click on an Audio Part, 

or

1. Select one or more Audio Parts.
You can edit Parts from several Tracks at the same time, if you like.

2. Pull down the Edit menu and select Edit, or press [Control]-[E] on the 
computer keyboard.

You can only have one Audio editor window open at a time.

The Audio Editor - overview

About Lanes

When you first open the Audio editor you will note that it is divided horizontally 
into something we call Lanes. You can move or copy Events between Lanes, but the 
results of this are different, depending on the audio channel setting of the edited 
Track:

• When Editing A Single Channel (Mono) Track.
If the Track is set to Mono, and set to play back on one specific audio chan-
nel, in the Arrange window (as opposed to being set to channel “Any”), the 
Lanes all have equal value. The only reason for you to use more than one 
Lane when editing a single channel Track is if you find that it gives you a bet-
ter overview of what is going on.

• When Editing a Stereo Track.
If the Track is set to play back in Stereo, the Audio Editor will show two differ-
ent Lanes, one for each stereo side. This means that if you edit a Stereo Track 
set to channel 3, the Audio Editor will display lanes for channel 3 and 4.
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• When Editing a Multi Channel Track.
If you are editing a Track set to channel “Any” (or several Parts on different 
Tracks), each Lane will represent one of the available audio channels. Which 
audio channel each Lane “uses” is indicated by a number on the left side of 
the window.

By moving an Event between Lanes with different channel numbers, you 
change which audio channel the Event is played back on.

● This chapter assumes you are editing Parts on the same audio channel. For 
more information about multi channel audio editing, see the Audio Editor 
chapter in the electronic documentation.

How Audio Events are displayed
Normally, Audio Events are displayed as boxes containing a waveform - or two 
waveforms if the corresponding audio file is in stereo. In addition, several handles, 
markers and other things can be shown in the Event. What is displayed depends on 
the setting on the View pop-up menu:

Waveforms

This option governs whether the waveform(s) should be shown or not. Usually, you 
will want to leave this option activated.

Names

When this is activated, the name of the segment is shown in the top left corner of 
the Audio Event.
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Handles

Each Event has a Start and End Inset which represent the Segment start and end 
points in the audio file. If the “Handles” option is activated on the View pop-up 
menu, handles for adjusting the Start and End Insets are visible in the upper and the 
lower corners (respectively) of the Events. For information about how to adjust the 
Insets, see page 166 in this chapter.

The shape of the handle indicates what the Event actually plays:

• Even if the Event doesn’t begin or end inside the window, the Start and 
End Inset symbols will be visible at the edges of the window. 
If you have long Events, this allows you to see the “status” of the Insets (as de-
scribed above) without scrolling the view.

The Handles option will also show/hide the Q-Points (see page 162).

By Output

When this is activated, all Events that play back on the same audio channel will be 
displayed on the same Lane. For more information about this, see the Audio Editor 
chapter in the electronic documentation.

Lane Info

If this option is activated a field will be shown to the left of each Lane, displaying 
the number of the corresponding audio channel.

If this symbol appears at the beginning of the Event, it means that the 
Event plays the audio file from the beginning.

If this symbol appears at the beginning of the Event, it means that the 
Event plays the file from some point later than the absolute beginning of 
the file. The Start Inset has already been adjusted.

If this symbol appears at the end of the Event, it means that the Event plays 
the audio file to its end.

If this symbol appears at the end of the Event, it means that the Event does 
not play the file to its absolute end. The End Inset has already been ad-
justed.

End Inset handleStart Inset handle Q-Point handle
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Dynamic Events

When this is activated, the lower part of the Audio Event will display a volume 
curve, a pan curve or Match Points. This is all described in the Audio Editor chapter 
in the electronic documentation.

About Q-Points

In the Audio Event, you will also find a vertical line with a handle, marked “Q”. 
This is the Q-Point, a marker that is used for snapping the Event to musical posi-
tions.

The concept behind this is that with audio, as opposed to MIDI, the beginning of 
the Event might not occur at a musical position at all, there might for example be a 
significant amount of silence at the beginning of the recording.

This means that snapping the beginning of the Event to a musical position normally 
doesn’t make much sense. Hence Q-points. These allow you to specify a position in 
the Segment which is to be taken as it's first “musically significant position”, the 
first down-beat for instance.

• To move the Q-Point in an Audio Event, just click and drag the Q-handle.
For the Q-Point to be visible, “Handles” must be activated on the View pop-
up menu.

For more info about working with Q-Points, see the Audio Editor chapter in the 
electronic documentation.
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Which Audio Events will I Hear?

If any two Audio Events try to play back on the same audio channel at the same 
time, only one of them will be heard. This is shown in the pictures below:

The ”1st Part” Event is cut off by the ”2nd Part” Event.

The ”MainBeat” Event is cut off by the ”Fill-in” Event. After the end of this shorter Event, the 
”MainBeat” Event will be heard again.
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Creating Audio Events
There are three general ways to create new Audio Events in the Audio Editor:

• By recording.
Audio Recording in the Audio Editor is done just as in the Arrange window. If 
you are editing several Parts on different Tracks, you determine which Part to 
record into by clicking in the Lane Info field to the left in the window.

• By importing.
If you select the Pencil tool and click somewhere in a Lane, a file dialog will 
open. Locate and select the audio file you want to import, and click OK. An 
Audio Event is created at the position where you clicked (taking the Snap 
value into account), and the file and segment is added to the Pool.
The file specifications are the same as when importing into the Pool (see page 
156).

• By dragging segments from the Pool.
This is done just like dragging segments into the Arrange window (see page 
153).
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Manipulating Audio Events
This section describes some of the basic ways of manipulating Audio Events.

Moving Events

Audio Events are moved just like other objects in Cubase:

1. Select the Arrow Tool.

2. Select all Events you want to move.

3. Press and hold the mouse with the arrow pointer over one of the selected 
Events (not in the handles) and move the mouse.
The mouse box shows you where the Q-point of the first selected and 
dragged Event will wind up when you release the button.

4. If you want to restrict movement to horizontally or vertically, hold down 
[Shift] while dragging.

5. Release the mouse button, and the selected Events are moved to the new 
position. 
The Snap function applies, positioning the Event so that its Q-point gets 
aligned with the closest Snap value.

You can also make fine adjustments to Event position, using the Hand tool. This is 
described in the Audio Editor chapter in the electronic documentation.

Duplicating Events

This works just as when moving Events, except that you press [Alt] and hold it 
down while you are dragging the Events. The duplicated Audio Events will play 
new segments, with the same properties as the original.

• If instead you want the duplicated Event to play the same segment, you 
can create a Ghost Copy of the Event, by holding down [Control] while 
you are dragging.
The advantages of this are that you don’t get a lot of identical segments in the 
Pool, and that you can edit one segment, and have your changes affect sev-
eral Audio Events at once. For more info about Ghost Copies, see the Audio 
Editor chapter in the electronic documentation.
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Changing Start and End Insets

Changing the Start and End Insets is the main way to trim your Audio Events. 
There are a couple of things to think about before starting:

• Snap to Zero.
If the option “Snap To Zero” in the Audio menu is enabled, all offset adjust-
ment will be followed by an automatic “search for a zero crossing”. The ad-
vantage of using zero crossings is that there will be no clicks due to sudden 
volume changes in the audio material. For more info on Zero Crossings, see 
the chapter “The Audio Editor” in the electronic documentation.

• Changing the Magnification.
It is often a good idea to zoom in horizontally and vertically when you are 
making fine adjustments to the segment start and end points. Use the sliders 
in the lower right corner of the window to change magnification.

• The Inset value is in ticks. 
There are 384 ticks for each beat (quarter note) which means that when you 
change the Insets this is the resolution you are using for the position value. 
However, if you need sample accurate editing of Segment Insets, you can per-
form this in the Pool, see the electronic documentation.

• The Insets do not “snap” to the closest Snap value.

Changing the Start Inset

The Start Inset is adjusted by dragging in the upper left corner of the waveform part 
of the Segment. Usually, you will point at the handle, click and drag, but the handle 
does not actually have to be shown (hide/show it with the View pop-up menu, if you 
like).

• If you click somewhere along the very top edge of the segment (though 
not on the segment name) the Start Inset will immediately be set to that 
position.
The Start Inset can also be changed numerically from the Info Line (see page 
170).

Position the pointer in the upper left corner of the 
waveform, and drag the Inset left or right.
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What happens when you Change the Start Inset?

Changing the Start Inset adjusts from which point in the file the Segment plays; it 
“hides” more or less of the beginning of the file. It does not move the audio in the 
Song. Note the difference between changing the Start Inset and moving the Event:

Changing the End Inset

This is done just as changing the Start Inset, only you click and drag in the lower 
right corner of the waveform. Changing the End Inset adjusts the Length of the 
Event; that is, it hides more or less of the end of the file.

• If you click somewhere along the bottom edge of the segment, the End 
Inset will immediately be set to that position.
The End Inset can also be set numerically on the Info Line (see page 170).

Monitoring the changes

If you activate the Speaker icon, a short section of the segment will be played back 
when you change the Insets, allowing you to fine-tune the settings by ear. In the 
electronic documentation, you find information about how to set the length of the 
section to be played back.

Before moving the Event

After moving the Event

Before moving the Start Inset

After moving the Start Inset
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Auditioning Audio Events

This allows you to check out the contents of an Event, by playing it back from any 
position: 

1. Select the Magnifying Glass from the Toolbox.

2. Make sure the Scrub icon on the Status Bar is deactivated.
When this is activated, the Magnifying Glass is used for Scrubbing. This is de-
scribed in the Audio Editor chapter in the electronic documentation.

3. Click on an Event.
The Event is played back from that point as long as you hold the mouse but-
ton down. The audio is routed through the monitor mixer as usual.

The Scrub icon deactivated 
(Auditioning mode).

The Scrub icon activated 
(Scrubbing mode).
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Deleting Audio Events
Audio Events can be deleted in several ways, just as Parts in the Arrange window:

• By clicking with the Eraser tool.
This will remove the Event from the Audio Part. The file will remain on the 
hard disk, and in the Audio Pool, together with the segment.

• By selecting the Event and pressing [Backspace] on the computer key-
board.
Again, this will only remove the Event from the Audio Part.

• By selecting the Event, holding down [Control] and pressing [Backspace].
If you do this, the following alert message will appear:

If you click No, only the Audio Event will be removed, as if you had not 
pressed [Control].
If you click Yes, the audio file will be permanently deleted from the hard disk, 
and the segment and file will be removed from the Audio Pool.

● Permanently deleting an audio file from your hard disk this way cannot be 
undone!
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Editing on the Info Line
The Info Line is a section in the window containing numerical settings for the se-
lected Audio Event. Proceed as follows:

1. To display the Info Line, click on the “I” button on the Status Bar:

2. Select one, and only one, Event.

3. Adjust the values as described in the table below:

Heading: Description:

Start Start Position. Adjusting this moves the Event.

End End Inset. Adjusting this shortens or lengthens the Event.

QPoint Q-point. Adjusting this moves the Q-point. See page 162 in this 
chapter.

Segment Segment name. If you change this, this is reflected in all Events 
that play the Event, and in the Pool.

File File name. Changing this means that the actual audio file on the 
hard disk is renamed.

Chn The audio channel the Event plays on. This cannot be changed 
on the Info Line.
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What can I do with the MIDI Editors?
When you record MIDI data, you fill Parts with notes and other MIDI “Events”. 
But you don’t really get to see and manipulate those Events individually from the 
Arrange window. In the MIDI editors you do!

Different types of Events and where to find them
Below we’ll list the different types of MIDI data that Cubase VST can record, and 
how and where they are displayed for editing:

Notes (Note On and Off messages)

Notes are displayed in all MIDI editors. Let’s look at a simple drum pattern and 
how it is shown in the different editors:

In Drum Edit

In the Drum Edit window, the notes are shown as diamonds. 
Each key corresponds to a Sound, as listed to the left. The different 
shadings of the diamonds indicate different velocity values.
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In Key Edit

In List Edit

The notes are shown as boxes, with higher notes higher up in the grid. 
Since this is a drum pattern, all the notes are short, but otherwise note 
length is indicated by the width of the rectangle.

The piano keyboard to the left is there to make it easy 
to find the right pitch when inputting or editing notes.

The notes are shown both in the list 
to the left, and in the graphic display to the right.

The black bar graphs are for graphically displaying and 
editing MIDI “Value 2” in every Event. In the case of 
notes, “Value 2” is the velocity value.
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In Score Edit

Continuous Messages

In MIDI, various types of MIDI messages are used to transfer continuous changes. 
To be exact, these types are:

• Aftertouch (Channel Pressure and Poly Pressure).
• Pitch Bend.
• Controllers, like sustain pedal, MIDI Volume, Modulation wheel etc.

To be really exact (not to say pedantic!) some of these are not really continuous. 
Sustain Pedal for example can only be down (On) or up (Off). However, the MIDI 
specification groups all these messages as Continuous messages, and so does Cu-
base VST.

In Score Edit, notes are displayed and edited 
just as notes on a printed score. 
This snapshot is taken from Cubase Score.
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Continuous messages are shown and edited in Key Edit and List Edit:

In Key Edit, the area beneath the Divider is the Controller Display.

Clicking on this icon brings up a pop-up menu, 
allowing you to select which type of continuous 
data should be shown. In this case, modulation 
wheel Events are displayed.

The “mountains” of continuous data (as shown in the Key Edit 
Window) are in reality a large number of single Events. This becomes 
clear when looking at the same data in the List Edit Window:

The modulation Events are 
listed in their playback order.

Value 2 for each Event is shown in the 
list and in the bar display. The grey 
color indicates non-note Events.
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Program Change messages

A Program Change message is a MIDI Event, telling a connected MIDI device to 
switch to another Program (e.g. a sound in a synthesizer, a setting in a reverb de-
vice, etc). You can record Program Change messages into Cubase VST like any 
other Event. If you want to edit (or create new) Program Change messages, it can 
be done in Key Edit or List Edit.

System Exclusive messages

System Exclusive messages are a special kind of MIDI Events, intended for de-
tailed control of the parameters of a MIDI device. Since all devices have different 
parameters, each major manufacturer of MIDI devices has a special ID code that is 
included in the System Exclusive message.

System Exclusive messages can be displayed and edited in the List Edit window 
(See the “List Edit” chapter). For extensive System Exclusive editing and manag-
ing, you can use the SysEx Editor module, described in a separate electronic docu-
ment.



- 177 - 

Opening A MIDI Editor
There are several ways to open a MIDI editor:

● If you haven’t recorded any MIDI data, but want to input MIDI Events “from 
scratch” in a MIDI Editor, you need to create a Part first, by using the Pencil 
tool or the Create Part function. This is described on page 121.

Double clicking on one Part

If the Part is on a Drum Part, the Drum editor opens. If it is a regular MIDI Part, 
which editor opens depends on the “Double Click Opens” setting in the Preferences 
dialog. To set this, proceed as follows:

1. Pull down the File menu and select “Preferences”.
The Preference dialog opens.

2. Pull down the “Double click opens” pop-up menu and select the pre-
ferred editor (Key, Score or List Edit).

The Double Click Opens setting is saved with the Song. If you want this setting to 
be valid for all new Songs, you should set up your “Def.ALL” song for this. See 
page 241.
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Editing a complete Track

You can edit all Parts on a Track at the same time:

For MIDI Tracks the “Edit“ item opens Key Edit, for Drum Tracks it opens Drum 
Edit.

Editing more than one Part

You can edit any selection of Parts, even Parts on different Tracks at the same time. 
The only restriction is this:

● List Edit can only be used to edit Parts that are all on the same Track.

1. Select the Parts you want to Edit.

2. Select the preferred editor from the Edit menu or use the keyboard 
equivalents.

1. Make sure no Parts are selected by clicking somewhere in 
the background area of the Arrange Window.

2. Select the Track you want to Edit.

3. Select the preferred editor from the Edit 
menu or use the keyboard equivalents.
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Key Edit

Overview

Below you will find a description of some of Key Edit’s main features:

The black notes are selected.

The position of the mouse pointer is shown both on 
the Piano keyboard and in the Mouse Box.

The Song Position 
Pointer.

Clicking here opens the Controller Display.

The Snap and Quantize 
boxes.

The Goto pop-up is used 
for moving the view.

The Do and To pop-ups. See “The 
MIDI Editors – General Information” 
in the electronic documentation.
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Drum Edit
Drum Edit can be used to edit MIDI Tracks. It can also be used in a more advanced 
context, for editing Drum Tracks. See the chapter “Drum Edit and Drum Tracks”.

Overview

Below you will find a description of some of Drum Edit’s main features:

The Song Position pointer.

The Do and To menus. 
See the chapter “The MIDI 
Editors – General Information” 
in the electronic 
documentation.

The position of the mouse is shown in the 
Mouse Box. The name of the Drum Sound 
on the corresponding line, is shown in the 
box below.

The Drum Sound list. By dragging the Divider 
further to the right, more columns are shown.

The black notes are selected.

Clicking here opens the Controller Display.
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About Drum Maps

In Drum Edit, each key on your MIDI keyboard is represented as a “Sound”, in a 
“Drum Map”. This map consist of 64 Sounds which can be named and set to repre-
sent a certain drum sound in your synthesizer, sampler or drum machine.

When you have defined a Sound, all notes that are already recorded with that Sound 
will appear as diamonds on that “line” in the note display.

Opening ready-made Drum Maps

A number of ready-made drum maps are included on the Cubase VST CD-ROM. 
This example describes opening a drum map for General MIDI instruments, but 
you may very well find a drum map which has been created specifically for the 
drum sounds in one of your instruments. To load a map, proceed as follows:

1. Select Open from the File menu.

2. From the File Format pop-up menu, select “Drumsets (*.DRM)”.

3. Locate the Drum Maps folder on the Cubase VST CD-ROM.
You may find it more convenient to copy the desired Drum Maps from the 
CD-ROM to your hard disk, and open them from there instead.

4. Locate the drum map you desire, and click OK.
For a General MIDI compatible drum map, open the Roland folder and select 
the “GS Standard” map. 
Now when you next time open the Drum editor, your Drum Map is already 
properly defined and recordings made in the Arrange window should appear 
with all the notes on the right “lines”.
If you save your Song, the selected drum map is saved together with the Song. 
It will be loaded automatically next time you open the Song.
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Setting up and changing the Drum Map

You can easily change an existing drum map, or set up a whole new one to fit the 
percussion and drum setups in your MIDI instruments.

● This example assumes you are using Drum Edit for editing MIDI Parts. 

Now, recordings made with the Sound played by that key will appear on that line.

1. Check out and take note of which key on your keyboard is used to 
play a certain Sound.
2. Open the Drum editor and drag the Divider between the Drum Map 
and the Note display so that you see the first few columns in the list.

3. Double click on a Drum 
Name and type in your own.

4. Double click on the I-note 
value for that Sound, and 
type in the pitch of the key 
that plays the Sound.
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If already recorded Notes don’t appear on the Line

It may happen that you have defined an I-Note correctly and still, no notes appear 
although they play back correctly. If this happens it is because more than one 
Sound is set to the same I-Note. Proceed as follows:

1. Scroll up or down the List to find a Sound set to the same I-Note as the 
one you want to use.

2. Scroll the I-note value of the Sound you just located to its lowest possible 
value (C-2).

3. Scroll back to the original Sound and check again.
The notes should now have appeared.

If you get the “Double defined Notes” message

When you change the I-note value, a dialog box may appear saying “Double de-
fined I-NOTE in your drum set”. This means that more than one Sound is set to re-
spond to the same MIDI Note, as described above.

This dialog will appear every time you open Drum Edit, until you change one of the 
identical I-note values.

Saving your Drum Map

You may of course save any Drum Maps you have created. This is described in the 
“Drum Edit and Drum Tracks” chapter in the electronic documentation.
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List Edit

Overview

The Song Position is shown both in the 
Event list and in the Event display

In the Insert pop-up menu, you decide which 
type of Events to input.

The Events are shown in the list 
and in the display to the right.

The Mask pop-up is used to 
make List Edit show Events 
of a certain type only. The Mouse position is 

shown in the Mouse Box.

The Do, To and 
Goto menus.
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Score Edit
The design and features of the Score editor differs depending on which version of 
Cubase VST you have: In the “regular” Cubase VST, there is a basic Score editor 
without advanced layout features, while Cubase Score VST contains a larger Score 
editor, for pro-level score layout and printing.

Unless where explicitly stated otherwise, this section and the Score Edit chapter in 
the electronic documentation describe the basic Score editor in Cubase VST. If you 
have Cubase Score VST or Cubase Audio VST you should also read the separate 
“Score Layout and Printing” document.

Overview

Below you will find a description of some of Score Edit’s main features:

Getting the Score displayed correctly

When you first open Score Edit, the score layout can reflect the minor inaccuracies 
of a real human performance. There are a number of settings that can be made to 
clean up the score layout, without having to change the actual MIDI data. See the 
Score Edit chapter in the electronic documentation for more info.

The “inverted” notes are selected.

The Song Position Pointer.

The mouse position is shown both in the mouse box and as a note name in 
the box below. When you move a note, the lower box shows the amount of 
transposition in semitones.

If you are editing Parts on several Tracks at the same time, the striped 
double bar line at the beginning of the score indicates the Active Track.
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Page Mode vs Edit Mode

If you are using Cubase VST Score or Cubase Audio VST, your program will have 
a Score menu. The top item on this menu is used to switch the Score editor between 
its two modes, “Page” and “Edit”.

The text below assumes the editor is set to Edit mode. The other mode is for score 
layout and printing. 

Users of the regular Cubase VST (not Score) do not have to worry about this.

Window Size

Score Edit’s Edit mode displays as many notes as there is room for in the window. 
In other words, to see more or less of your Track, simply resize the window.

Selecting Page Mode will display the 
music as it will look when printed...

...while Edit Mode displays the music in a 
way more suitable for editing, see below.
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About Recording and Playback in the Editors
Basically, anything you can do in the Arrange window that relates to playback and 
recording, you can also do in the editors.

• Realtime
As everything else in Cubase VST, editing can happen in realtime. This means 
that you can edit while the music is playing or actually even while you are re-
cording!

• Step Recording
If you prefer not to record your music in real time, you may use the Step Re-
cording function to input music one note at a time. This is explained in the 
chapter “Step Recording” in the electronic documentation.

• Follow Song
If Follow Song on the Options menu is turned on, the window automatically 
scrolls during playback, so that the current Song Position is always visible.

You may also press [F] on the computer keyboard to turn Follow Song on/off.

• Edit Solo

When this button is activated, you will only hear the Track/Parts that are cur-
rently being edited. All other Tracks are muted. Use this function when you 
want to concentrate on editing the Parts in the editor, rather than hearing the 
recording in a context.

• Cycle
Activating Cycle (see page 87) can be very handy for editing, since you can 
fine tune a recording and instantly hear the result without having to Rewind 
and Play to get to the right section.
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Entering Notes
Notes can be entered manually, using slightly different methods in the different 
MIDI editors:

Key Edit

1. Set the Snap value to the smallest position you want to enter a note at.
If for example you only want to enter notes at quarter note positions, set Snap 
to “4”.

2. Set the default length of the note to enter with the Quantize value.
The value “8” will for example give eighth notes. You may also change the 
length while you’re drawing - see page 189.

Snap and Quantize values set up for entering eighth notes at quarter note intervals.

3. Select the Pencil tool.

4. Move the pointer onto the note display, to the position where you want 
the note to be placed.
The keyboard display to the left, and two fields on the Status Bar will help you 
by showing the position and pitch.

5. Click once with the mouse to input a note.

The pitch is indicated on the keyboard 
display and in the Status Bar.
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Setting the length while drawing 

It is possible to set the length of notes to something else than the quantize value, 
while entering them. Still the Snap value applies so you can only set the Length to 
even multiples of this value.

1. Aim with the Pencil at the correct position and pitch.

2. Press the mouse button and drag to the right with the button pressed.

3. Release the mouse button. 
The Event is adjusted to the closest Snap value.

Determining the velocity of the notes

By holding down different modifier keys on the computer keyboard, you can give 
the notes you enter different velocity values. This is described in the chapter “The 
MIDI Editors - General Information” in the electronic documentation.
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Drum Edit

1. Drag the Divider to the right, so that you can see the “Q” and “Len” col-
umns.

2. Locate the Sound you want to enter notes for, and set the value in the “Q” 
column to the smallest position you want to enter a note at.
When inputting notes, this value works in the same way as the Snap value in 
Key Edit. However, Drum Edit allows you to set different Q values for each 
Sound, making it easier to quickly input patterns with 16th note hihat patterns 
and eighth note snares and bass drums, etc.

3. Set the default length of the note to enter in the “Len” column.
Again, you may set different values for different Sounds.

Q and Len values set up for entering a 16th note hihat pattern.

4. Select the Drumstick tool.

5. Move the pointer onto the note display, to the position where you want 
the note to be placed.

6. Click once to input a note.
If you want to remove a note, just click on it again with the Drumstick.

Two fields on the Status Bar will help 
you by showing the position and Sound.
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Entering several notes at once

If for example you want to enter a 16th note pattern, there is an easier way of doing 
this than clicking in the notes one by one:

1. Set up Q and Len values for the Sound.

2. Select the Paint Brush tool.

3. Aim at where you want the first note to be, click and drag to the right.

4. Release the mouse button.
A row of notes are entered, positioned according to the Q value for the Sound.

Determining the velocity of the notes

By holding down different modifier keys on the computer keyboard, you can give 
the notes you enter different velocity values. This is described in the Drum Edit 
chapter in the electronic documentation.
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List Edit

In List Edit, you can insert any type of Event. However, in this example, we will in-
sert notes (see the List Edit chapter in the electronic documentation for more infor-
mation).

1. Pull down the Insert pop-up menu and make sure “Note” is selected.

This is where you select the type of Event to enter.

2. Set the Snap and Quantize values as when entering notes in Key Edit.

3. Select the Pencil tool.

4. Aim and click in the Event display to the right of the List.
The Event will appear both in the Event display and in the List. 

• You can set the length of the note manually while you are entering it, just 
like in Key Edit (see page 189).

When you enter a note in List Edit this way, it gets a default pitch. To change the 
pitch of the note, proceed as follows:

5. Drag the divider to the right, so that you can see “Val 1” column in the 
List.
For Note Events, Value 1 is the pitch.

6. Change the pitch value using any kind of value editing.
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Score Edit

In Score Edit, you use the Note tool to input notes:

1. Set the Snap value to the smallest position you want to enter a note at.

2. Select the Note tool.

3. Select a note value by clicking on a note button on the Toolbar.

The Note tool takes on the shape of the selected note value.

4. Press the mouse button somewhere in the score display.

5. With the mouse button down, drag the note up/down. 

Accidentals appear to show you the exact pitch of the note. The pitch is also 
shown in the value field under the Mouse Box:

6. When you have the note at the right note line with the correct acciden-
tal, release the mouse button.

Entering Rests

You can use the Rest tool to insert rests between notes. Like the Note tool, the Rest 
tool changes appearance depending on the chosen note value. See the Score Edit 
documentation for full details.
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Selecting Notes and other Events
• Selecting Notes and other Events in the main Event displays is done exactly 

like when selecting Parts in the Arrange window, see the previous chapter.
• Selecting Events in the List in List Edit can be done by clicking and Shift-click-

ing.
• You may use the Select sub-menu in the Edit menu to select Events. The con-

tents of this sub-menu varies depending on which editor you are in. See the 
Online Help for more information.

• Selecting in the Controller Display in Key and Drum Edit is slightly different. 
See the chapter “The MIDI Editors – General Information” in the electronic 
documentation.

Manipulating Notes
This section describes some basic MIDI editing techniques. Two features are avail-
able to make editing easier:

• The Snap value.
The Snap value is used in the editors just like in the Arrange window, that is 
for restricting movement and editing to certain note positions. However, in 
the MIDI editors you can select smaller Snap values than in the Arrange win-
dow, for very fine adjustments of positions and lengths.

• The Speaker.
If you activate the Speaker button on the toolbar, notes and other Events will 
be played back when you click on them, move them or edit them on the Info 
line (see page 196).
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Moving Notes

You move notes by dragging them with the Arrow tool, just like moving Parts in the 
Arrange window. If you select several notes, you can move them all at once, main-
taining the relative distance between the notes.

Restricting movement to one direction

Sometimes you may want to transpose the note without moving it sideways, or vice 
versa. Proceed as follows:

1. Aim at the note with the Arrow tool and press the mouse button.

2. Start moving the note in the desired direction.

3. Press [Shift] and continue moving the note.
The note will now move in one direction only.

• You can also use the Kicker tools to move a note horizontally in Snap 
value steps.
This is described in the electronic documentation.

Duplicating Notes

Again like in the Arrange window, if you hold down [Alt], the notes you drag will 
be duplicated.

Changing the length of Notes

The following method can be used in Key and List Edit, to change the length of 
notes:

1. Set Snap to an appropriate value.
The length of the note can only be a multiple of the Snap value.

2. Select the Pencil tool.

3. Click on the right edge of the note, drag the outline of the note to a new 
length and release the mouse button.
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Auditioning Notes

If you click on a note with the Magnifying Glass tool, it is played back. You can 
also drag over notes (and other Events) to play them back one after the other.

Deleting Notes
Just like Parts in the Arrange window, Notes (and other Events) can be deleted in 
several ways:

• By clicking on them with the Eraser tool.

• By selecting them and pressing [Backspace] (or selecting Delete Events from 
the Edit menu).

• By using various functions on the Do pop-up menu (described in the elec-
tronic documentation).

Editing on the Info Line
At the top of each editor (except List Edit), you have the Info Line. This can be 
shown/hidden with the Info button.

The Info Line shows the values for one selected note. The values can be edited, just 
as in the List in List Edit.

When the “i” button is activated, the Info Line is shown.
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Editing in the Controller Display
Key and Drum Edit have a dedicated Controller Display at the bottom of the win-
dow, for showing velocity values and Events other than notes. You can also edit 
these in List Edit - see the List Edit chapter in the electronic documentation.

Showing/Hiding the Controller Display

There are two ways to show or hide the Controller Display:

• Click on the Controller Display button in the lower left corner of the 
window.

• Press [Alt]+[Control]-[C].

Once you have opened the Controller Display, you can change its size by dragging 
the Divider up or down:
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Selecting which Event type should be shown

The Controller Display can show various types of data, but only one type at the 
time. Select an Event type in the following way:

1. Position the pointer on the Event type icon (in the Controller Display) 
and press the mouse button.
The Event Type pop-up menu appears.

2. Select one of the Event types from the pop-up menu.
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Editing velocity

One of the data types that can be shown in the Controller Display is note velocity. 
This is slightly different from the other types, since velocity is not an Event itself, 
rather a property of a note. This means that if there are no notes in the edited Part, 
you will not see any velocity values. Also, you cannot create velocity values (you 
have to enter new notes). To edit velocity, proceed as follows:

1. Select Velocity on the Event type pop-up menu.
The velocity values are shown as bars, with higher bars representing higher 
velocity values.

2. Select the Pencil tool.

3. To change the velocity of a note, click on its velocity bar.

To change a series of values, drag over them.
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Creating a velocity ramp

To create a ramp of values, for example a fade-in or fade-out, proceed as follows:

1. Select the Line tool.

2. Position the pointer where you want the ramp to start and press the 
mouse button.

3. “Draw” the outline of the ramp with the mouse button pressed.

When you release the mouse button, the velocity values are changed:
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Editing Continuous Events

Most of the available Event types are “Continuous” Events, such as Aftertouch, 
Modulation and Pitch Bend (see page 174). They can be created and edited in the 
Controller display:

Creating new Events

1. Select what type of data you want to enter.

2. Use the Snap value to decide what “density” you want for the Events.
For very smooth Continuous Controller curves, you should use a small Snap 
value. However, please note that this creates a very large number of MIDI 
Events, which can cause MIDI playback to “stutter” in some situations. A me-
dium-low density is often sufficient.

3. Hold down the [Alt] key.
From here on there are basically three ways to go:

4. Release the [Alt] key.

If you want to enter just one Event, click once with the Pencil.

If you want to “paint a curve”, drag the 
Pencil (with the mouse button pressed).

If you want to create a ramp, use the Line tool as when editing velocity.
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Editing the Values

This is done just like creating new Events, except you do not press the [Alt] key:

• To change one value with the Pencil, simply click on it.

• To change a series of values, drag over them with the Pencil.

• To create a ramp, use the Line tool.
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Closing the Editor
There are two ways of closing a MIDI editor, “Cancelling” and “Keeping”.

Cancelling

If you press [Esc] (escape) on the computer keyboard or select “Cancel” from the 
Edit window’s Control Menu (reached by clicking on the Control Menu button to 
the left on the window’s title bar), the editor and all the changes you made since 
you last opened it are discarded.

• If you haven’t checked the “Fewer Alerts” check box in the Preferences 
dialog (on the File menu), a dialog box allows you to change your mind:

Cancelling can be thought of as a super-undo. It allows you to try out a series of 
changes to a recorded piece of music and then easily revert back to its original state.

Keeping

If you close the editor by  selecting “Keep” from the Control Menu or by pressing 
[Return], the window closes and all the editing you have made is kept.

“Cancel” will cancel all changes you 
have made since you opened the editor.

“Keep” will exit the editor, 
but keep your changes.
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The “Keep Appended Events?” Dialog

If you close the editor and a dialog appears asking you if you want to “Keep ap-
pended Events”, this is because you have added Events outside the Part(s) being ed-
ited.

• If you click “Yes”, the Part will be extended to encompass the added Events.
• If you click “No”, the Events outside the Part will be discarded.
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Using Quantize and Functions 15
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How Functions are applied
By using “functions” you can perform various operations on notes and other MIDI 
Events, and in some cases on Audio Events as well. Some of the most important 
functions, such as the different types of Quantization, can be found on the Func-
tions menu on the menu bar. In addition, the editors have their own “miniature” 
Functions menus, called the “Do” menus.

The main Functions menu and one of the Do menus – they both contain “functions”.

However, before explaining how the functions work, it is important to know exactly 
what is affected by a function:
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In the Arrange Window

If you use a function from the Arrange window, it will apply to all selected Parts. If 
there are no selected Parts, the function will apply to all Parts on the active Track.

In the Editors

All the editors feature a pop-up menu called “To”. There you can decide which 
Events should be affected by a function. The menu options are explained in this fig-
ure:

All Events, active or 
inactive, will be 
affected.

This option has to do 
with the Loop feature, 
which is described in 
the electronic 
documentation..

This option has to do with the Loop 
feature which is described in the chapter 
“MIDI Editors - General Information” in 
the electronic documentation..

Only the selected 
Events inside the 
Cycle are affected.

All active or inactive 
Events inside the 
Cycle (between the 
left and right locators) 
will be affected, 
whether the Cycle is 
on or off.

All selected Events, 
active or inactive, 
will be affected.
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Quantizing

What is Quantizing?

Quantizing in its fundamental form is a function that automatically moves recorded 
notes, positioning them on exact note values: 

The Quantize value concept may need some explanation. By setting this value, on the 
pop-up menu on the Status Bar, you select the exact positions the notes should be moved 
to when you quantize. These are the options:

The effect of the different Quantize values is explained in the illustration on the 
next page.

If you for example record a series of eighth notes, some of them may 
end up slightly beside the exact eighth note positions.

Quantizing the notes with the Quantize value set to eighth 
notes will move the “misplaced” notes to exact positions.

If you select OFF, no 
quantizing will be done.

In the left column, you select 
Triplet (T) Quantize values.

In the middle column you select regular 
Quantize values. The available values 
range from 1 (whole note) to 64 (1/64 note).

In the right column, you select 
dotted (.) Quantize values. In this example a Quantize value 

of eighth note triplets is selected.
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Quantizing with different Quantize values

Quantizing with an eighth note 
triplet Quantize value moves the 
each second eighth note, creating 
a triplet shuffle beat.

Quantizing with a dotted eighth note 
Quantize value moves notes to 
positions three sixteenth notes apart.

Quantizing the eighth note pattern with a quarter 
note Quantize value, will move every second 
eighth note to even quarter note positions.

It is important to realize that there will now be two notes on each 
beat! This may cause strange sounds, increased volume etc. 

Start with a straight eighth note pattern.
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Actually, quantizing in Cubase VST is more than just correcting errors, it is a crea-
tive feature. On the Functions menu, there are several types of quantization. The 
three most important ones are described in this chapter. The rest are described in 
the electronic documentation.

● When quantizing MIDI Parts, only notes are affected, not other types of 
Events. 

About Quantizing Audio Parts

Quantizing Audio Parts affects the position of each Audio Event in the Part (taking 
the Q-point into account). Since Audio Parts in many cases contain only one Audio 
Event, quantizing audio is often not very useful. However, it is possible to split an 
audio segment into several smaller segments, and then apply quantization. This is 
described in the electronic documentation.
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Over Quantize

This is a very musical version of the standard “auto correct” quantize. Over Quan-
tize will move notes to the closest quantize value, without changing the length of 
the notes. But it also detects and holds together chords (see the figure below) and if 
you consistently play behind of, or ahead of the beat, it uses this fact when finding 
notes to move. In most situations, Over Quantize is probably the most suitable 
Quantize function to use.

• Over Quantize can be selected from the computer keyboard by pressing 
[Q].

When you Over Quantize (in this 
example with a quantize value of 4), 
Cubase VST realizes that the three notes 
are a chord, and holds them together.
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Iterative Quantize

If you want to straighten up the timing of your notes a little, but don’t want the pre-
cise feel you get from using Over Quantize, Iterative Quantize is probably the best 
bet. It works like this:

Instead of moving a note to the closest quantize value, Iterative Quantize moves it 
only part of the way. You can specify how much the notes should be moved towards 
the selected quantize value in the dialog box that appears when you select Setup 
Grooves... from the Functions menu.

In the same dialog you can also set a value in ticks (0 to 192) called Don’t Quan-
tize. Only notes further away than the specified Don’t Quantize value are moved. 
This lets you allow a certain amount of loose timing, while still being able to 
straighten out really “off” notes.
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Creating a Shuffle Feel using Iterative Quantize

To show the difference between regular quantizing and Iterative Quantize, let’s 
look at two identical eighth-note patterns:

The upper set of notes are Over 
Quantized to eighth note 
triplets...

The upper pattern gets a heavy, precise triplet feel...

...while the lower pattern gets a more jazzy, natural shuffle feel.

...while the lower set of notes are Iterative 
Quantized using the same Quantize value. 
Strength is set to 66%. (Don’t Q is set to 20, 
but doesn’t really matter in this case.)
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Groove Quantize

This type of quantizing is not meant for correcting errors, but for creating rhythmic 
feels. This is done by comparing your recorded music to a “Groove Map” (a pattern 
with a certain feel) and moving the appropriate notes so that their timing matches 
the one of the Groove Map. You can for example easily create the shuffle feel from 
the Iterative Quantize example above, using a suitable Groove Map instead.

You select a Groove Map from the Groove Quantize sub-menu on the Functions 
menu. As you see, there are more than a dozen Groove Maps included with Cubase 
VST from the beginning, but you can also load new ones from disk or make up your 
own, (using the Setup Grooves dialog, described in the Online Help).

Undoing Quantize

● Quantizing is not definite or irrevocable - not even after saving to disk! You 
can always re-quantize to any value, even to Off, unless you specifically 
“freeze” your Quantize, with “Freeze Quantize” (Functions menu). 

This means that notes quantized to eighths can later be quantized to sixteenths. The 
original (un-quantized) positions of the notes are used for determining how notes 
should be moved, except when using Iterative Quantize. You can re-quantize just 
some notes in one of the Edit windows.

To completely restore quantized Events to their original positions, use the Undo 
Quantize function on the Functions menu. This can be applied to any selection of 
Parts or individual Events, just as all Functions (see page 206).

The Grooves included with Cubase VST are described in detail 
in a ReadMe file in the Grooves folder on the CD-ROM.
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Automatic Quantize - Getting your music quantized while recording

This is a function that allows you to have everything automatically Quantized as 
you go along with your recording. When automatic Quantize is activated, every-
thing you record is Over Quantized immediately. The quantization can be undone, 
just as usual.

The AQ Button (above the Click button on the Transport Bar) turns on and off Au-
tomatic Quantize. You can also press [Z] on the computer keyboard to activate/de-
activate.

● There is one thing to note. If you have this function activated, your recording 
gets Over Quantized at the end of each Cycle. Even if you select some other 
type of Quantizing (like Groove Quantize) during the Cycle, the music will be 
Over Quantized at the end of the Cycle. So, before you manually Quantize, 
turn Auto Quantize off.

Other Functions
The Functions menu is not only used when quantizing, it contains a lot of other 
functions as well. In addition the “Do” menus in the editors contain useful editing 
functions. The same rules as for Quantizing are used to decide what gets affected. 

The various functions on these menus are described in the Online Help and in the 
electronic documentation.

Automatic Quantize activated.
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Mixing 16
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Introduction
This chapter describes the general procedures of handling levels, pan, EQ and ef-
fects to create a final stereo mix. Mixing is done in different windows in Cubase 
VST, mainly the Audio Monitor mixer (for audio) and the GM/GS/XG Editor (for 
MIDI).

● The GM/GS/XG Editor is designed to interact with MIDI instruments compat-
ible with any of the standards GM (General MIDI), GS or XG. However, even 
if your instrument is not GM/GS/XG compatible, you may still be able to use 
some of the functions in the editor.

Mixing Audio

● This chapter assumes that you are using a “standard” audio card with stereo 
outputs only. If you have an audio card with more than two outputs, you can 
route different audio channels to different outputs, using the Bus system. This 
is described in the chapter “The Input/Output Bus System” in the electronic 
documentation.

Setting Levels

1. Set up your Audio Tracks and possibly the Locators, so that they play 
back the section you want.

2. Pull down the Audio menu and select “Monitor” (or press [Control] and 
[*] on the numeric keypad).
The Monitor mixer window opens.

3. Select “Master” from the Audio menu (or press [Control] and [+] on the 
numeric keypad).
The Master window opens. This is used to set the final level of the mixed sig-
nals. 
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4. If possible, try to arrange the windows so that you can see both the Mon-
itor mixer and the Master window at the same time.

5. In the Monitor mixer window, make sure the “In” buttons are not acti-
vated for the audio channels.
When these are activated, the level meters show the input level instead of the 
playback level.

6. Make sure neither the “Read” or the “Write” buttons are activated.
These are used for automating mixer movements, as described in the elec-
tronic documentation. For now, we’ll stick to manual mixing.

7. Activate playback, and use the faders to set the relative volume for the 
audio channels.
The fader settings are displayed numerically below the faders. You can boost 
weak signals by +6 dB in the Monitor Mixer, if you like. Just be sure to avoid 
signal levels above 0 dB (clipping - see page 66).

Clipping is indicated by the red 
clip light above the “In” button. 
To reset the clip indicator, click 
on it.
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• For stereo channel pairs, the faders are automatically “linked”, i.e. mov-
ing the fader for the left channel will automatically move the fader for 
the right channel, and vice versa.
Stereo channel pairs are indicated by the word “Stereo” at the top of the 
mixer channel strips. To set the level independently for one channel in a 
stereo pair, hold down [Alt] and drag the fader.

• If you hold down [Control] and click on a Monitor fader, it will automat-
ically be set to position 0.0 dB.

8. Adjust the total volume with the faders in the Master window.
The faders are linked, i.e. if you move one fader the other will move as well. 
If you want to adjust the level of one stereo channel independently, press [Alt] 
and move the fader.

About automating levels

There are two ways of automating level settings:

• By using the Write/Read function in the Monitor Mixer.
As described in the chapter “Mixing Audio and using Effects” in the electronic 
documentation, this allows you to record and play back fader movements (as 
well as most other mixer and effect settings).

• By using the Dynamic Event feature in the Audio Editor.
This allows you to set volume curves for individual Audio Events. See the Au-
dio Editor chapter in the electronic documentation.
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Setting Pan

With the Pan controls, you set the stereo position of each audio channel. Like vol-
ume, pan settings can be automated using the Write/Read function or the Dynamic 
Events in the Audio Editor.

• When you are changing Pan for a channel, the setting is shown numeri-
cally (L63–R63) in the level display below the fader.
To make the display show the fader setting again, click the fader handle.

• To select center Pan position, hold down [Control] and click on the Pan 
control.

• For audio channels in a stereo pair, you should probably pan the left 
(odd-numbered) channel fully left and the right (even-numbered) fully 
right.

● If the Mono switch in the Master window is activated, all audio playback will 
be in mono, and the Pan settings will have no effect.

The Mono switch
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Using Mute and Solo

For each audio channel, there is a Mute and a Solo button, which can be of great use 
when you want to listen closely to one or several audio channels. These work as fol-
lows:

• Clicking the Mute button silences the output of the audio channel.
To deactivate Mute, click on the button again.

• Clicking the Solo button silences the output of all other audio channels.
You may Solo several audio channels at the same time if you like. To deacti-
vate Solo, click on the button again.

Mute and Solo settings can be automated using the Write/Read functions in the 
Monitor Mixer. See the electronic documentation.

The MIDI Mute button

Activating the MIDI Mute button will turn off all MIDI output. Use this when you 
want to concentrate on the audio, setting levels, eq, etc. Closing the Monitor win-
dow will automatically deactivate the MIDI Mute function.
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Making Equalizer settings

Cubase VST is equipped with a powerful equalizer. Depending on your computer 
power and available free resources, you can have up to 4 bands of full parametric 
EQ per audio channel!

Each audio channel has its own EQ window. To activate and set EQ for a channel, 
proceed as follows:

1. Click on the “EQ” button at the top of the channel strip.
The EQ and FX Send window opens. This contains a duplicate of the Monitor 
mixer channel strip, four effect send knobs (see page 224) and 1–4 EQ mod-
ules.

An EQ and FX Send window with two EQ modules visible and active.

● If you make Equalizer settings for the left channel in a stereo channel pair, the 
settings will automatically be reflected in the right channel.

2. Use the arrow buttons in the top right corner to set the number of visible 
EQ modules.
This helps you avoid “screen cluttering” by hiding unused modules.

3. Activate as many EQ modules as you need (up to four) by clicking on 
their “Enable” buttons.

As soon as any of the EQs are activated, the “Active” button and the “EQ” button indicator in 
the channel strip are lit.
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● The maximum total number of EQ modules (for all channels together) is gov-
erned by your computer’s performance. If you activate more EQ modules 
than your system can handle, you will note that the “Over” indicator in the 
Audio Performance window lights red, and the audio playback stutters and 
distorts. Keep an eye on the Audio Performance bar graphs and deactivate a 
number of EQ modules, until the computer load seems normal.

4. Set the parameters for the activated EQ module.
It is perhaps easiest to set up a playback cycle and experiment with the set-
tings until you get the desired sound. The three basic EQ parameters are:

The other EQ parameters are described in the chapter “Mixing and Using Effects” 
in the electronic documentation.

● Please note that high Gain values may give rise to distortion. Check the chan-
nel level meters and compensate with the channel volume faders.

5. Close the EQ window by clicking on its close box in the upper left corner.
In the Monitor window, the “EQ” button indicator for the audio channel will 
now be lit, which means EQ is applied to that channel.

Turning EQ on and off from the Monitor Mixer

When you have enabled the desired EQ modules and made settings, you can turn 
equalizing on and off for the channel from the Monitor Mixer window, by holding 
down [Control] and clicking the “EQ” button for the channel. This toggles the sta-
tus of the Active button in the EQ and FX Send window.

Gain Governs the amount of boost or attenuation around the set fre-
quency. The value range is ± 12 dB.

Frequency The center frequency for the equalization. Around this frequency, 
the sound will be boosted or attenuated according to the Gain set-
ting. The range of the Frequency parameter is determined by the Hi 
and Lo Limits.

Q Determines the width of the frequency band around the center fre-
quency to be affected. The narrower frequency band, the more 
drastic effect of the boost or attenuation.
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Applying Effects

There are three basic types of effects in Cubase VST; insert effects (applied sepa-
rately to each channel, by using the channel inserts in the Monitor Mixer), send ef-
fects (applied separately to each channel by using the effect sends in the Monitor 
Mixer) and master effects (effects that accept a stereo input, and are inserted into 
the master mix). Typical uses for insert effects would be distortion, filters, auto pan-
ners or any effect that you want to send a whole channel through. Typical send ef-
fects would be reverb, delay, chorus or anything that you want to apply in different 
amounts to the different audio channels. Typical master effects would be noise re-
duction units, compressor/limiters or effects that change the stereo characteristics 
of the final stereo signal.

In this section, we will only describe how to use send effects. Insert and master ef-
fects are described in the chapter “Mixing and using Effects” in the electronic doc-
umentation.

Routing an Audio Channel through the Send Effects

You can have four different send effects in Cubase VST, and you can send the sig-
nal from each audio channel to any combination of these four effects. Proceed as 
follows:

1. In the Monitor Mixer window, click on the EQ button for the audio chan-
nel you want to apply effect to.
The EQ and FX Send window opens, as described on the previous pages. The 
section between the channel fader and the EQ modules contains the effect 
sends.

2. Make sure the “DRY” button is not activated.
When this button is activated, all four effect sends are deactivated for the 
channel.

3. Click on the “On” button for the effect sends you want to activate and 
turn the corresponding Send level knob to a moderate value.
Remember that the Effects rely heavily on the processing power in your com-
puter. The more activated sends and effect units, the more computer power 
will be used for effects.

Send level

Pre-fader Send switch

Dry Button (affects all four sends)

Send routing popup

Send On/Off
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4. Pull down the Send Routing pop-up menu for each activated effect send, 
and make sure they are assigned to different effect slots.
This pop-up allows you to freely route each effect send to any of the four send 
effect slots, or even to an output on your audio card (see the chapter “Mixing 
Audio and Using Effects” in the electronic documentation). 

It is possible to assign two or more effect sends to the same effect slot, but this 
would probably only lead to distortion in the effect unit.

5. If you want the signal to the effect to be independent of the channel 
fader setting, click on the PRE button for the send.
With Pre-fader effect sends, the amount of effect for the channel is not af-
fected by the volume fader. With Post-fader effect sends (PRE button not acti-
vated), the amount of effect is proportional to the channel volume, and will 
change with the volume fader movements. This is the most common setting.

The next step is to select programs and set the parameters for the effect processors. 
Since you will probably need to adjust the send levels while doing this, leave the 
EQ window open.
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Selecting Effects and making settings

You select effect types and programs in the Effects window:

1. Click the big FX button to the left in the Monitor Mixer window (or select 
Effects from the Audio menu).
The Send Effects window opens. This window resembles an effect rack, with 
separate “processors” arranged on top of each other. 

2. Activate an effect processor by clicking on its “Power” button.

3. Pull down the pop-up menu in the processor’s upper right corner and se-
lect an effect type.
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You can select between the following effects (for more detailed descriptions, see 
the separate Acrobat documents for each Effect Plug-in):

Other effects may be included with the program when you purchase it. There are 
also additional Effect Plug-Ins separately available - contact your Steinberg dealer 
for more information. Furthermore, Cubase VST can also use DirectX compatible 
plug-ins installed on your computer - see the chapter “Installing and using external 
effect plug-ins” in the electronic documentation.

4. Click in the middle of the Prog. button, to put the processor in Program 
mode.

5. Step between the effect programs, either by clicking on the left or right 
part of the Prog. button or by rotating the value dial.
The number of program locations depends on the selected effect type. It 
might be a good idea to set up a cycle and have the audio channel play back 
while you are making settings, to hear the effect of your selected effect pro-
grams.

● Not all Effect Plug-Ins have ready-made programs. See the On-line help and 
the documentation included with each Plug-in.

6. Use the send level knob in the EQ window to control the amount of ef-
fect for the audio channel.

Effect Description

Choirus A chorus and flanger effect, which adds “depth” and “anima-
tion” to a sound.

Espacial A reverb effect, adding ambience and “room quality” to the 
sound.

Auto Pan Makes the sound move automatically between the left and 
right channel.

Stereo Echo A delay effect, with the possibility to set different delay times 
for the left and right channel.

Fuzz A simulation of a typical transistor fuzzbox.

WunderVerb 3 A reverb that provides smoother, denser reverberation.

Grungelizer Adds crackles, hiss, distortion and filtering, for a true “lo-fi” 
sound.
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7. Use the Effects Master knob to the left on the processor panel to set the 
amount of input level to the effect processor.
If you set this to a high value, it might cause clipping (distortion) in the effect 
processor. If the output of an effect processor is clipped, an indicator will light 
up (this feature is not necessarily supported by all Effect Plug-Ins).

8. If you want to, repeat steps 2 – 7 for the other effect processors.
Avoid activating effect processors that you don’t use, since this draws some 
extra processor power. To minimize the processor load, pull down the Effect 
type pop-up for the unused processors, and select “No Effect”.

● The effect settings can be automated, as described in the chapter “Mixing Au-
dio and Using Effects” in the electronic documentation.

Effects Master knob

Clipping indicator
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Mixing MIDI
If you have a MIDI instrument that supports any of the standards GM (General 
MIDI), GS (Rolands extension of GM) or XG (Yamahas extension of GM), you can 
use the GM/GS/XG Editor to “mix” the sound of your MIDI instrument, by send-
ing MIDI messages to the instrument. These messages include volume, pan, pro-
gram change and effect settings (GS/XG only). For more information about GM, 
GS and XG, see page 236.

● If your instrument does not support any of the standards mentioned, you may 
still be able to use some of the functions in the editor, such as volume and 
pan. Refer to the instrument’s documentation and to the MIDI message list in 
the Mixer chapter in the Online documentation.

Working with GM/GS/XG Instruments

The empty Song that gets automatically loaded when Cubase VST is first installed, 
is set up so that each track transmits on one of the 16 MIDI Channels. This corre-
sponds to how the GM/GS/XG editor is set up. To avoid confusion, we recommend 
that you keep this Track/Channel layout when recording music for GM/GS/XG 
sound modules.

The GM/GS/XG editor settings are saved with the Song and should be seen as an 
intuitive hands-on approach to quickly build a good sounding mix. 
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Opening the GM/GS/XG Editor

There are two ways to open the editor window:

• Pull down the Edit menu and select “GM/GS/XG Edit”.

• Press [Control]-[Y] on the computer keyboard.

Selecting Output and Mode

Before you start mixing, you need to make sure the editor is set to the correct Mode 
and sends on the desired MIDI Output. This is done in the Device section:

1. Pull down the Output pop-up menu and make sure that the correct MIDI 
Output is selected.
This should be the Output to which your GM/GS/XG instrument is connected.

2. Use the Mode pop-up menu to select the desired mode (GM, GS or XG).
• Select GM if your instrument is General MIDI compatible, or if you have a 

non-GM compatible instrument but still want to use some of the mixer func-
tions.

• Use Roland GS or Yamaha XG mode only if you have a Roland GS or Yamaha 
XG compatible instrument and wish to access some of the additional features.
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3. Use the On/Off/Reset button to make your instrument ready for GM/GS/
XG operation.
This button has different labels and functionalities depending on which Mode 
is selected:

In GM mode, this button is used to switch your instrument in and out of Gen-
eral MIDI mode. Click on the button to send the command that is currently 
shown to your instrument.

In GS/XG mode, this button is labelled “GS/XG Reset”. Clicking it resets all 
controls in the window, as well as any connected GS/XG instrument, to their 
default values.
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Selecting Sounds

You can select a General MIDI sound for each MIDI channel (except channel 10, 
which is used for drums) by using the hierarchical Program pop-up menus at the 
bottom of each “channel strip” in the mixer.

The sounds are organized in 16 instrument groups, each containing eight sounds. 
To select a sound, pull down the pop-up, move the pointer to one of the instrument 
groups and select the sound from the sub-menu that appears.

Selecting Drum Kits

If your instrument supports GS and XG, you can use the Program pop-up menu to 
select a Drum Kit for MIDI channel 10 (which is reserved for drums).

● The Program settings in the GM/GS/XG Editor are not reflected in the Inspec-
tor and vice versa. Also, if you use ready-made GM Scores that include Pro-
gram changes, these will not be reflected in GM/GS/XG Edit.
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Setting Levels and Pan

You can use the Mixer section in the GM/GS/XG Editor, to set levels, pans, etc for 
each MIDI channel. Even though this has the “feel” of a normal mixer, it actually 
works quite differently: The GM/GS/XG Editor mixes and changes the sound by 
sending MIDI messages to the instrument. If the mixer parameters don’t seem to 
work as expected, you should check that your MIDI instrument really is capable of 
(and set to) receiving the MIDI message in question.

● For a list of which MIDI messages are sent by each parameter, see the chapter 
“The GM/GS/XG Editor” in the electronic documentation.

The Mixer section.

The following controls are available for each MIDI channel:

• Volume fader.
Drag the fader to change the volume of the corresponding MIDI channel.

• Pan.
Use this to set the position in the stereo image for the corresponding MIDI 
channel. The Drum channel (channel 10) has no panning control.

• Reverb level.
Although this is not a part of the GM specifications, many GM instruments 
(and all GS/XG instruments) have a built-in reverb that can be controlled via 
the standard MIDI controller number for reverb (#91). If this is so, use this 
value field to set the amount of reverb for the channel.
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• Chorus level.
Like the Channel Reverb controls, this parameter is not a part of the GM spec-
ification. However, some GM instruments (and all GS/XG units) have a built-
in chorus (sometimes flanger or delay) that can be controlled via the standard 
MIDI controller number for chorus depth (#93). If this is so, use this value 
field to set the amount of chorus for the channel.

● In GS or XG Mode, you can make additional effect settings, as described be-
low. 

• Mute switch (GS/XG mode only).
In GS/XG Mode (see below), the channel number fields above the faders can 
be used as Channel Mute buttons. You can mute/unmute each channel indi-
vidually by clicking on the respective button.
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Effect Settings (GS/XG Mode only)

If your instrument supports GS or XG, you can use the GM/GS/XG editor to select 
and make settings for effects in the instrument. This is done in the Effects section of 
the window (which only appears in GS or XG mode).

The Effects section contains the following global settings for the reverb and chorus 
effects that are included in all GS/XG instruments:

• Reverb pop-up
Lets you select one of eight reverb types. The available reverb types are differ-
ent in GS and XG instruments. In XG mode, selecting “No Effect” allows you 
to easily turn off the reverb completely.

• Reverb time
Lets you change the overall reverb time.

• Chorus pop-up
Lets you select one of eight chorus- and related effect types. The available ef-
fect types are different in GS and XG instruments. In XG mode, selecting “No 
Effect” allows you to easily turn off the effect completely.
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What is GM/GS/XG?

General MIDI

General MIDI (GM) is a standard set up by the MIDI Manufacturers Association 
(MMA) and the Japanese MIDI Standards Committee (JMSC).

It defines a standardized group of sounds and the minimum requirements for Gen-
eral MIDI compatible synthesizers or sound modules, so that a specially prepared 
sequence or MIDI file that is sent to the instrument via MIDI will play back the cor-
rect sound types, regardless of make and model of the instrument.

MIDI identifies sounds by their program change number. Before the General MIDI 
standard was introduced, the same MIDI program change number often addressed 
totally different types of sound in any two synthesizers or sound modules from dif-
ferent manufacturers, eg, a flute type sound in one instrument and a piano type 
sound in the other. 

With the introduction of General MIDI standard compatible instruments this 
changed. These instruments use the same program change numbers for the same 
types of instruments.

So, if the person that prepared a sequence or MIDI file wants the melody to be 
played by a "piano", he can use a certain program change command embedded into 
the sequence to automatically select a piano sound in any GM compatible sound 
module. The GM standard does not specify in great detail how that piano should 
sound. It is simply assumed that the manufacturer reproduces an acoustic piano 
within the capabilities used of the instrument.

General MIDI supports all 16 MIDI channels. Each channel can play a variable 
number of voices (thus be polyphonic). Each channel can play a different instru-
ment (or sound, or program). A minimum of 24 fully dynamically allocated voices 
are simultaneously available for both melodic and percussion sounds.

Furthermore, in GM compatible instruments, percussion and drum instruments 
which are key-based always use MIDI channel 10 and specific note numbers are re-
served for specific drum sounds.

There are a number of other MIDI messages that GM compatible instruments 
should respond to. Among these are the MIDI controller events for Volume (Con-
troller 7) and Pan (controller 10). By using these controllers it is possible to create 
a MIDI Mix for a piece of music.

Roland GS

This is a variation of General MIDI introduced by Roland. It defines additional 
standard procedures for selecting alternate drum kits and sound variations, and for 
setting a number of other parameters in Roland GS compatible instruments. 

Yamaha XG

This is a variation of General MIDI introduced by Yamaha. It defines additional 
standard procedures for selecting alternate drum kits and for setting a number of 
other parameters in Yamaha XG compatible instruments. 



- 237 - 

17

File Handling 17



- 238 - 

Saving

Which file format should I choose?

There are three document formats you can use for saving your music: Song, Ar-
rangement or MIDI File. You should only choose MIDI Files if you want your mu-
sic (MIDI only - no audio) to be playable in other sequencers (see page 244). If you 
want to save your music for further use in Cubase VST, you should use either the 
Song or the Arrangement format:

Song

When you save a Song (*.All), the following information is included:

• All the Arrangements.
• The Pool, all audio settings and audio file references (but not the actual audio 

files themselves).
• The entire Setup, that is, settings in dialogs and on menus, Groove maps, 

Transport Bar settings etc.
• The Drum Map.

Arrangement

When you save an Arrangement (*.Arr), the following is included:

• All the things you see in one Arrange window; the Tracks, the Parts, Inspector 
settings, tempo, etc.

The audio file references, however, are stored in the Pool, and the Pool is not part of 
the Arrangement. This means that if you only save an Arrangement, there will be no 
audio files to reference to! Therefore:

● When doing audio work with Cubase VST, we recommend that you always 
save complete Songs!

If you have only recorded MIDI, the Arrangement format is often perfectly ade-
quate for saving a piece of music. The pros and cons of both formats are shown in 
the table on the next page.
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● Even though the Song files contain all audio references, they do not contain 
the actual audio files! If you want to transfer a Song containing audio to an-
other computer, you need to move the audio files as well. The Prepare Ar-
chive and Prepare Master functions in the Pool make this easier - see the Pool 
chapter in the electronic documentation.

File Format Advantages Disadvantages

Arrangement • Takes up little disk space.

• Can be saved, and opened in 
another Song, which is an easy 
way to transfer music between 
different Songs.

• Does not contain “unnecessary” 
settings if all you want to save is 
the MIDI music.

• Opening an Arrangement does 
not affect settings in dialog boxes 
and on menus, which, in some 
situations, is an advantage.

• Does not contain any au-
dio settings and references.

• Does not contain a com-
plete “snapshot” of the pro-
gram’s “state”.

Song • Contains the Pool and all other 
audio settings.

• Contains more than one Ar-
rangement.

• Saves all the settings on all 
menus, in all dialog boxes etc.

• Includes the Drum Map.

• Takes up more disk space 
than the Arrangement file 
format, even if you only have 
one Arrangement in the 
Song.
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Performing the Save

1. Pull down the File Menu and select “Save As...”
The file dialog appears.

2. Use the standard controls to find the location on your hard disk where 
you want to save the file.

3. Use the file type pop-up to select a format, Song or Arrangement.
The other file formats are primarily used for “extracting” special elements of a 
Song file. See the Online Help for details.

4. Type in a name for the file.

5. Click the OK button.

Using “Save Song”

On the File menu you will find a menu item called “Save Song”.

• If you have already saved your Song once (using “Save As...”) selecting Save 
Song (or pressing [Control]-[S] on the computer keyboard) will save your 
Song without asking for a file name and location. The file you save now will 
simply overwrite the earlier version.

• If you have not yet saved your Song, selecting “Save Song” is the same as se-
lecting “Save As...”.

File List

Cubase VST File type popup

File Name

File navigation popup
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About the default Song

Each time you launch Cubase VST, a default Song called “Def.All” is opened. This 
makes it possible to customize the default functionality and layout of the program:

1. Launch the program. 

2. Set up the program as you want it.
This may include the number and organization of Tracks, MIDI setup, Drum 
Map, Metronome settings, Audio settings, Part color and appearance and 
much more. See the Customizing chapter in the electronic documentation.

3. Select “Save As” from the File menu.

4. Navigate to the Cubase VST program folder.

5. Type in the name “Def.All” (without the quote signs) and press OK.
You will be asked if you want to replace the current Def.All file. Click Yes.

Next time you launch Cubase VST, you will automatically get your desired setup 
and layout.

About the Autosave Feature

In the Preference dialog on the File menu you find a setting called Autosave. If you 
activate this, you can set how often the program should automatically save your 
Song. The Song is saved under the name “Backup.all” in the Cubase VST program 
folder.
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Opening
1. Select Open... from the File menu.

The Open dialog appears.

2. Use the File Type pop-up to select which type of file you want to open, 
Song or Arrangement.

3. Use the standard controls to display the correct folder on your hard disk.

4. Click on the file in the file list.
The list will only show documents of the selected type.

5. Click OK.

File List

Cubase VST File type popup

File selected for opening
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About opening Songs

If the file is a Song, you will be prompted with a reminder that the Song you open 
will replace the Song you have loaded now. If this is not what you want, Cancel and 
Save the existing Song first.

About closing Songs

There is no way to close the Song in Cubase VST! The Close command on the File 
menu only closes the current Arrangement, as described on page 131. If you want 
to create a new Song, you should use the New Song command on the File menu.

About opening Arrangements

If the file is an Arrangement, it will appear as a new window on screen, in addition 
to any Arrange windows already open. You can have up to 16 Arrangements in your 
Song at the same time.
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Exporting in MIDI File format
You might want to export an Arrangement as a Standard MIDI File, so that it can be 
loaded into other computer programs or hardware sequencers, for example.

● A Standard MIDI File contains MIDI data only - no audio. Any Audio Tracks in 
your Arrangement will automatically be excluded from the created MIDI file.

1. Mute all the Tracks you don’t want included in the MIDI File.

2. Pull down the File menu and select “Preferences”.
The Preferences dialog appears. 

Use the “Leave MIDI File Track Data as is” checkbox to determine what hap-
pens with the Inspector settings, such as Program Change, Transpose, Vol-
ume, etc:

• If the checkbox is activated, the Program Change, Bank Select, Pan and Vol-
ume settings in the Inspector are ignored. All other settings are converted to 
“real” MIDI data and included in the MIDI file.

• If the checkbox is not activated, all Inspector settings will be converted to 
“real” MIDI Events and included in the MIDI file. When the MIDI file is im-
ported (into Cubase VST or other sequencers) it will play back just like before 
you exported it. In most cases, this is the preferred mode.

3. Pull down the File menu and select ”Export MIDI File...”.
The file dialog appears.

4. Select a name and location for the file.
The file will automatically get the extension “.MID”, which is the standard ex-
tension for MIDI files.

5. Click OK.
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MIDI File formats

Cubase VST normally saves MIDI files in format 1. This means the Track structure 
is preserved in the file (even though all Parts on each Track will be linked together 
into one long Part). However, if you Export a MIDI File with only one Track un-
muted, a MIDI File of type 0 is created.

Importing MIDI Files
1. Pull down the File menu and select Import MIDI File...

Cubase VST recognizes files as MIDI Files if they have the extension “MID” 
(the standard extension for MIDI Files).

2. Use the dialog box that appears to decide if you want the file to appear 
in a new Arrange window or if you want to merge the MIDI File into the 
current Arrangement.
If you choose the latter option, the file will appear in the current Arrange-
ment, starting at the Left Locator position.

The file dialog appears.

3. Locate the file.
Click on the file in the File list.

4. Click OK.

When importing MIDI Files, the data is automatically split up into shorter seg-
ments (Parts) to make it easier to edit the music in the Arrange window.



- 246 - 

Handling Audio Files
Audio files can be imported and exported in several ways:

• By using the Import and Export commands in the Pool.
These also allow you to export a segment and make it an audio file of its own.

• In the Arrange window, by using the Import and Export Audio File com-
mands on the File menu.
The Export Audio File command lets you mix down several Audio Tracks into 
one audio file.

• You can also import audio files directly into the Audio Editor, using the 
Pencil tool.

All these functions are described in detail in the electronic documentation.

Make Backups of your audio files!

Needless to say, it is essential that you back up your audio data regularly, preferably 
on other media. There are various functions to make it easier to manage your audio 
files, described in the Audio Pool chapter in the electronic documentation.

Handling ReCycle Files
Cubase VST can import files created by Steinberg ReCycle, a powerful tool for 
working with drum loops and similar sampled material. This allows you to use Re-
Cycle together with Cubase VST, without the need of a sampler. This feature is de-
scribed in detail in a separate chapter in the electronic documentation.
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Creating Events 192
Sizing Events 189

Local On/Off 54

Locators
Moving Song Position to 106
Pre-programming 109
Punching In and Out 82
Recalling Pre-programmed 109
Setting 68, 108
Setting up the Cycle 87

M
M Column 134
Magnification 39
Magnifying Glass Tool

Arrangement 126
Audio Editor 168
MIDI Editors 196

Master Button 102
Master Effects 224
Master Track 102
Master Window 218
Meter Position 36
Metronome 60
MIDI

About 13
Connecting 51
Recording 77
Selecting Programs 75

MIDI Channel
Column in Track List 136
In the Inspector 144
Setting for Recording 73

MIDI Editors
About 172
Closing 203
Controllers In 197
Creating Notes In 188
Manipulating Notes In 194
Opening 177
Play Parameters in 147
Recording In 187

MIDI File
Exporting 244
Format 245
Importing 245
Saving an Arrangement as 244

MIDI Mute Button 221
MIDI Thru 54
MIDI Tracks 120
Mix Mode 93
Mixer

Audio (Monitor) 218
External 45
MIDI (GM/GS/XG Editor) 229

Mixer Tracks 120
MME 47
Monitor Mixer 218
Monitoring 46, 65
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Audio Track 63
Master Window 220

Move
Audio Events 165
Notes 195
Parts 124
Tracks 116

Multi Recording 98
Multimedia Extensions 47
Mute

Arrange Window 134
Audio Monitor Mixer 221
GM/GS/XG Editor 234

N
Naming

About 39
Arrangement 130
Parts 121
Tracks 115

New Arrangement 130
New Song 243
Normal Mode 94
Note Info Line 196
Note Off 79
Note On 79
Note Tool 193
Notes

About 79
Creating 188
Deleting 196
Editing 172
Moving 195
Resizing 195

Numeric Key Pad 101

O
Online Help 11
Open

Arrangement 243
Audio Files 164
MIDI Files 245
Song 243

Output
Audio 217
Inspector 144
Track Column 137

Over Quantize 211
Overdub Mode 78
Overdubbing

Audio 70
MIDI 78

P
Paint Brush Tool 191
Pan

Audio Monitor Mixer 220
GM/GS/XG Editor 233
Inspector 145

Part Appearance 128
Part Color 129
Part Display 15
Parts

About 121
Appearance 128
Creating 121
Deleting 69, 127
Duplicating 124
Joining 126
Moving 124
Naming 121
Overlapping (Audio) 70
Overlapping (MIDI) 78
Resizing 125
Selecting 122
Splitting 125

Patch (Inspector) 144
Pencil Tool

Arrange Window 121
Audio Editor 164
MIDI Editors 188

Pitch Bend
About 79
Creating 201
Displaying 201
Editing 202

Pool
About 150
Dragging Parts from 153
Importing files 156

Position
Meter 36
Relative Changes 105
Setting 103
Time 36

Position Slider 103
Program Change

About 79
GM/GS/XG Editor 75, 232
Inspector 144
MIDI Editors 176

Punch In
About 82
Automatic 82
Manual 84

Punch Mode 93
Punch Out

About 82
Automatic 85
Manual 86
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Quantize

Automatic 215
Freezing 214
Groove 214
Iterative 212
Over 211
Undoing 214

Quantize Last Version 96
Quick Start Song 23

R
Record Info 143
Recording Levels

About 46
Checking 66

Repeat 124
Replace Mode 78
Reverb (Audio) 227
Reverb (MIDI)

Level 233
Time 235
Type 235

Rewind 103
Right Locator 68
Roland GS 236

S
Sample Rate 59
Save Song

Automatic 241
vs "Save As..." 240

Saving 238
Scissors Tool 125
Score Edit

About 185
Page/Edit Mode 186

Scrubbing
Audio Editor 168
MIDI Events 196
MIDI Parts 126

Segments
About 150
Changing Start and End Insets 166
Dragging into Arrangement 154
In the Pool 152

Select Audio File Folder 65
Selecting

Notes 194
Parts 122
Tracks 115

Send Effects 224
Set Aside (Arrangement) 131
Shuffle 213

Snap 104, 194
Snap To Zero 166
Solo

Arrange Window 135
Audio Monitor Mixer 221
MIDI Editors 187

Song
Creating 243
Opening 243
Saving 238

Song Position Pointer 103
Sound Card See Audio Card
Speaker Icon

Audio Editor 167
MIDI Editors 194

Splitting Parts 125
Start and End Insets

About 166
Changing 166

Stereo
Audio Track 63
Master Window setting 220

Stereo Echo 227
Style Tracks 120
System Exclusive

About 80
Editing 176

System Setup 47

T
T Column 136
Tape Tracks 120
Tempo 60, 102
Thru

and the Inspector 148
Audio 65
MIDI Setting 54

Ticks 36
Time Locked Tracks 136
Time Position

About 36
Switching To 110

Time Signature 60, 102
To Pop-up Menu 207
Toolbox 34
Tools 34
Track Class

About 119
Changing 119
Column 136

Track Columns 133
vs Inspector 146

Track Name Column 136
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Tracks
About 113
Active 115
Changing Order Of 116
Class 119
Creating 114
Deleting 118
Duplicating 117
Naming 115
Selecting 115

Transport Bar
About 100
Hiding and Showing 100
Key Commands 101
Moving 100

Transpose 144

U
Undo

About 42
Audio Recording 69
Editing (Cancel) 203
Quantize 214

V
Values 37
Velocity

Creating Ramp 200
Editing 199
Inspector 145

View pop-up (Audio Editor) 160
Volume

GM/GS/XG Editor 233
Inspector 144
Monitor Mixer 218

W
Wave Editor 20
World Wide Web 11
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X
XG

About 236
Resetting 231

Y
Yamaha XG 236

Z
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